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What is Mail OnNet?

Mail OnNet is a complete electronic mail (e-mail) system running on PCs connected to a network 
(whether the network is a LAN or the Internet) through an open standards mail server. In many 
installations the server will be running UNIX, but it may be running DOS, OS/2, NT, VMS, or a mainframe 
operating system running TCP/IP protocols. Mail OnNet retrieves your e-mail from the mail server using 
well-established network mail protocols, Post Office Protocol version 2 (POP2) and version 3 (POP3). 
When you send a message, Mail OnNet uses another well-established network mail protocol, the Simple 
Mail Transfer Protocol (SMTP), to send your messages to the mail server.

While using Mail OnNet to read your messages, you can launch another application, such as KEYview 
(the default viewer), to view attachments that have been sent to you. Mail OnNet also has commands for 
composing messages, adding attachments to them, replying to messages, and forwarding messages to 
other users. You can create automatic tasks that perform actions on your messages according to such 
criteria as the date or the sender, and perform such activities as calling a program to act on the message, 
or saving the message to a file.

When you receive messages, they are placed in the In-Tray folder in the Mail OnNet message store. Your 
list of messages may grow over time, and Mail OnNet lets you use various commands to help you 
organize your messages into folders that you create in the message store. If you want to store the names 
and electronic mail addresses of your correspondents for future use, you can do so in the Mail OnNet 
address book. Mail OnNet also lets you customize your way of working. For example, you can change the
fonts that Mail OnNet uses, create forms to use as templates for messages you often send, and add 
signatures to messages automatically.

Sharing Data with MIME
Mail OnNet implements the MIME Internet standard, which lets you send many types of data across the 
Internet. You can send spreadsheets, formatted text, graphics, sound clips, or any of the many other 
types of file you may use. The MIME standard also lets you send simple mail messages to users who do 
not have a MIME-compliant mail system like Mail OnNet.

Using MAPI to Send Mail from Other Applications
Mail OnNet also lets you send mail directly from any of the increasing number of applications conforming 
to the MAPI standard. When using a MAPI-aware application, sending mail is as simple as choosing Send
from the File menu of the application.

Related Topics
Before You Start to Use Mail OnNet 
Composing a Message
Connections: the World Beyond Your LAN
The Internet: A Global Network for Everyone
Logging On to Mail OnNet
Mail OnNet Main Window
MAPI: Sending Mail Directly from Your Applications
MIME: Mail is More Than Words
Reading a Message
Sending a Message



The Internet: A Global Network for Everyone

The Internet is a set of computer networks that have been joined together by network gateways, all of 
which rely on the TCP/IP suite of protocols for communication. It has been established for many years 
and is the largest and fastest growing global network in existence. Once connected to the Internet, you 
can communicate directly with millions of other users. More and more organizations and individuals are 
connecting to the Internet for private and public communications. This growth has meant that there has 
been a pressing need for better electronic mail (e-mail) programs to work with the Internet. Mail OnNet 
utilizes well-established network communication standards to meet that need.

Related Topics
Connections: the World Beyond Your LAN
Mail OnNet Main Window
MAPI: Sending Mail Directly from Your Applications
MIME: Mail is More Than Words
What is Mail OnNet?



Connections: the World Beyond Your LAN

To send messages from your PC across the Internet, you must be connected to the network. Proprietary 
LAN-based mail systems place their emphasis on mail communication within the LAN. If you want to send
a message beyond the LAN, this usually requires going through a proprietary gateway to connect to a 
network outside the LAN. This may work if your recipients use the same proprietary gateway and LAN 
system; if they do not, your mail may get reduced to the lowest common denominator of the sending and 
receiving systems, which often means just simple text messages.

Mail OnNet communicates directly with a mail server using standard Internet data communication 
protocols, avoiding the restrictions that may be imposed by a gateway. This lets you send the information 
that you want to send, not just the information that the mail system allows you to send.

Mail OnNet uses the Simple Mail Transfer Protocol (SMTP) to send mail. Mail OnNet messages are 
formatted to use the MIME standard, so that the messages can retain their complex formatting as they 
pass through mail gateways on computer networks.

Related Topics
The Internet: A Global Network for Everyone
Mail OnNet Main Window
MAPI: Sending Mail Directly from Your Applications
MIME: Mail is More Than Words
What is Mail OnNet?



MIME: Mail is More than Words

On the Internet, there is an increasing need to communicate a large variety of information at both the local
and the global levels. For example: 

· A regional sales office wants to report monthly sales figures to the main corporate office by sending a 
spreadsheet document.

· A consultant wants to submit a proposal to some clients as a formatted document produced in a word-
processing application.

· A graphic artist wants to send an image to be included in a document.

Until recently, the Internet provided no standard mechanism for carrying messages with these features. 
The introduction of the MIME standard means that one can now send virtually any type of data across the
Internet, provided that the mail software complies with the MIME standard. Mail OnNet fully implements 
the MIME standard, letting you send and retrieve complex messages with multiple components, formatted
text, and multimedia messages.

An important feature of MIME is that it has been designed to follow existing Internet standards. This 
means that MIME messages can be retrieved by any existing Internet installation. Existing mail readers 
developed before the MIME standard was introduced will be able to retrieve your MIME messages, and, 
at the very least, they will be able to read the text of messages, allowing the non-text components to be 
extracted for processing by other software.

Related Topics
Connections: the World Beyond Your LAN
The Internet: A Global Network for Everyone
Mail OnNet Main Window
MAPI: Sending Mail Directly from Your Applications
What is Mail OnNet?



MAPI: Sending Mail Directly from Your Applications

Mail OnNet provides a window for composing and editing text messages, and you can also use this 
window to attach files produced in other applications. This is fine if you just want to send a quick message
or reply to another message, but if you want to send a document such as a spreadsheet in this way, you 
would have to create the spreadsheet file in a spreadsheet application, save the file, start Mail OnNet, 
attach the spreadsheet file to a message, and then send it. What you really want to be able to do is send 
the message directly from your application. Mail OnNet uses the Microsoft MAPI standard to address this 
need. Applications that have been written to the MAPI standard are referred to as MAPI-aware, because 
they know how to use MAPI-based mail systems like Mail OnNet to send information. Many Microsoft 
Windows applications are now MAPI-aware.

The MAPI standard defines how applications and mail systems relate to each other through the Windows 
operating environment. To send mail from a MAPI-aware application, choose Send from its File menu.

Related Topics
Connections: the World Beyond Your LAN
The Internet: A Global Network for Everyone
Mail OnNet Main Window
MIME: Mail is More Than Words
Sending Messages from MAPI-Aware Applications
What is Mail OnNet?



Mail OnNet Main Window

Select areas of the window to find out how to use them.

Related Topics
Before You Start to Use Mail OnNet 
Composing a Message
Logging On to Mail OnNet



Reading a Message
Sending a Message
What is Mail OnNet?



The standard Windows control box has an extra item, Check Mail, which is equivalent to Check Mail from 
the File menu.



The File menu



The Edit menu



The View menu



The Folders menu



The Message menu



The Settings menu



The Tools menu



The standard Window menu



The standard Windows Help menu



The toolbar contains buttons that you can use to perform commands, rather than by choosing them from 
the menus. Each toolbar button has a short description that displays when you move the pointer over the 
button with the mouse.

You can set whether to display the toolbar by choosing the Toolbar command from the View menu. 



The minimized Message Store window



A minimized Message List window



A minimized Read window



A minimized Compose window



A minimized Form window



A minimized Signature window



The right-hand side of the status bar shows whether CAPS LOCK, NUM LOCK, Overwrite mode, Offline mode,
or Online mode is enabled, and the left-hand side displays help cues if you press the mouse button while 
the pointer is over a menu command or tool.

You can choose whether to display the status bar using the Status Bar command from the View menu.



Before You Start to Use Mail OnNet

The first time that you start Mail OnNet, you are prompted to enter a username and password in the Mail 
Logon dialog box. You can either select Create New User, or type your username and password in the 
text boxes provided, then choose OK. If you are not already a user known to Mail OnNet, the application 
displays a series of dialog boxes to let you configure it.

When you request electronic mail (e-mail) service, your service provider or system administrator can give 
you access to a network mail server. Before you attempt to configure Mail OnNet for your use, make 
certain that your Internet service provider or system administrator gives you the following information 
about the network to which you are connected, which you will need to provide as you configure Mail 
OnNet:

· The IP address or full hostname and domain name of your network mail server. For example, your 
mail server might have the IP address 128.127.50.100, and its full name might be 
mailserv.xyz.com.

· The network mail protocol used by the mail server that receives your mail, from which Mail OnNet 
retrieves your messages. Mail OnNet supports both Post Office Protocol version 2 (POP2) and version
3 (POP3) for getting mail.

· Your assigned username and password on the mail server that receives your mail. Mail OnNet 
requires that you provide this information so that it can use it to retrieve your messages from the mail 
server.
Note:  The assigned POP username/password pair is separate from the username and password that 
you configure for logging on to Mail OnNet at your PC. The POP username/password pair is assigned 
to you by your Internet service provider or network system administrator for access to the POP mail 
server; the username and password that you use to log on to Mail OnNet at your PC are created by 
you, and are used only on your PC.

· Your PCs full hostname and domain name, such as personal.xyz.com. Internet service providers 
and system administrators assign a host and domain name to all PCs that are connected to their 
networks.

· Your e-mail address, such as jdoe@xyz.com. Internet service providers and system administrators 
assign an e-mail address to all mail users that are connected to their networks.

Note:    The DOS TMP environment variable defaults to the root directory of the C drive (C:\). If you are 
not using the default directory for this variable, make certain that you specify the directory location as the 
setting for the DOS TMP environment variable in your AUTOEXEC.BAT file, so that Mail OnNet has a 
directory in which to store temporary files. For example, you can include in your AUTOEXEC.BAT file the 
following line:

TMP=D:\TMP

Once you have configured Mail OnNet on your system, you will not need to make further changes to its 
configuration unless there are changes to your network operating environment, or if you want to add 
another user of Mail OnNet on your PC.

Related Topics
Logging On to Mail OnNet
Mail OnNet Main Window
What is Mail OnNet?



    Address Book
The address book is a collection of names and electronic mail addresses, in which you can define 
entries by associating the personal names of your recipients with their fully qualified e-mail addresses. 
By relying on the address book, Mail OnNet lets you type a simple name like Jane Doe into your 
message header fields instead of a fully qualified e-mail address like jane_smith@dept.xyz.com. 
You can type names, addresses, or both when you type in the message header fields, because you 
store both names and addresses in your address book.



    Attachments
Attachments can contain complex documents, such as those produced by using a word processor, 
spreadsheet program, desktop publishing system, graphic art or drawing program, presentation 
package, project management package, or database application. Attachments can also contain long 
text files.



    Distribution Lists
Distribution lists are entries that you create in your address book to let you send an electronic mail 
message to many recipients at once. To add a personal distribution list to your address book, you must
provide it with its own name and the email address of at least one recipient. To add recipient 
addresses to or remove them from a distribution list, edit the list in the Mail OnNet Address Book 
dialog box.



    Domain Name
A domain name uniquely identifies a network in the Internet community. The domain usually consists 
of two parts: the unique name (which may be abbreviated) for the organization that owns and 
maintains the network, and the name that indicates the type of organization that owns the network. For
example, the domain name for FTP Software, Inc. is ftp.com, where ftp is a unique short name 
identifying the company, and com identifies the company network as a commercial one.



    Gateway
A network gateway is a computer or device that is used to connect dissimilar networks (those using 
different communication protocols), so that information can be passed from one to the other. The 
gateway converts the information to a form that is compatible with the protocols used by the other 
network and transfers the information to that network for delivery to its destination.



    Hostname
A network hostname is the name assigned by administrators to a computer that is connected to the 
network, to identify it in a unique way. (People also find names to be easier to remember than IP 
addresses.) The hostname is independent of the IP address of that computer. In the example 
chocolate.xyz.com, chocolate is the hostname, and xyz.com is the domain name.



    Local Area Network (LAN)
A LAN is a group of computers and other devices (such as printers) that are directly connected 
(networked) to one another in the same physical area, where area may refer to the same building, site,
or radius of approximately one kilometer. Computers on the same LAN can exchange data (such as 
information found in files, database records, and messages) by using the same data communication 
protocols over compatible media. Users rely on their networked computers to communicate and share 
information.



    Message Store
The message store is a file system directory in which all of your electronic mail folders and messages 
are stored.



    MIME
The Multipurpose Internet Mail Extensions standard, which allows you to send complex formatted 
documents over the Internet.



    Network Mail Server
A mail server is a computer on a network that sends, receives, and forwards electronic mail for the 
users who are given access to its services by the system administrators who maintain the network.



    Offline Mode
Offline mode lets you use Mail OnNet without being continuously connected to your mail server. You 
can compose messages and add them to a queue in the Out-Tray folder for later delivery, and you 
receive messages only by choosing Check Mail from the File menu or toolbar.



    Online Mode
Online mode is the default mode for using Mail OnNet. Mail OnNet sends a message to the mail 
server after you choose Send in the Compose window. The program automatically searches for and 
retrieves new mail according to your configured mail settings, as well as when you prompt the program
to do so by choosing Check Mail from the File menu or toolbar.



    Password
Your password is a string of characters (upper- or lowercase letters, numbers) that you enter as part of
your credentials for gaining access to your mail. Your password ensures that only those who know 
your password can get access to your mail messages.



    Toolbar
A group of icons that appears below the menu bar. These icons let you gain access quickly to the 
application's features.



    Username
Your username is a unique identifier that you enter as part of your credentials for gaining access to 
your mail.



Sending a Message

To send a message from a Compose window, choose the Send button. You can also choose Send from 
the Message menu, or choose the F5 key on your keyboard. If you have set the Use Animation, Sending 
E-mail option in the User Preferences dialog box, the animation of a letter being sent on its way appears 
on your screen after you choose Send.

When you send a message, Mail OnNet places the message temporarily in the Out-Tray folder until the 
time the message is actually sent. Your message will be sent to the mail server as soon as possible. If 
your PC is not connected to your network (the Internet or your LAN), the message remains in the Out-
Tray folder until the next time that your PC is connected and you start Mail OnNet. In addition, if there is 
another task being performed by Windows, your message may not be sent until after Windows finishes 
with the other task.

After sending your message, Mail OnNet moves a copy of the message to the Sent folder. You can 
disable this feature or specify another default folder for saving sent messages in the Compose Options 
dialog box. To save a copy of the message that you are currently composing into a different folder, choose
the Options button to display the Local Compose Options dialog box. For the When Sending Mail, Save to
Folder option, specify the name of the other folder.

Related Topics
Composing a Message
Correcting the Spelling of Your Messages
Queueing and Delivering Messages While in Offline Mode
Sending Mail from MAPI-Aware Applications



Composing a Message

Use Compose windows to write and edit your messages before you send them.

To compose a mail message
1. Choose Compose Mail from the Message menu or the toolbar to open a Compose window.

2. Type the names or addresses of your recipients into the To: and Cc: boxes, using a semicolon (;) to 
separate the different addresses.
--or--
Choose Address if you want to use the address book to help you enter the correct addresses.

Note:    Mail OnNet opens Compose windows when you reply to and forward messages sent to you. If 
you are replying, Mail OnNet fills in the To: and Cc: message headers for you when the Compose 
window first opens. You can edit the headers just as you can the message body.

3. In the Subject: box, type the subject of your message. If you are forwarding or replying to a message, 
this header is filled in for you, but you can edit the Subject: header to contain whatever you want as 
your subject.

4. Move the cursor to the message text box below the message header boxes, then type your message.

--or--
Choose Import Text from the Edit menu to display the Windows Open dialog box. Browse for and 
choose the text file that you want to insert into the message body at the position of the cursor.

5. If you want to include an attachment with your message, choose Attach. The Windows Open dialog 
box appears. Select the file you want to attach to the message, then choose OK. Your attached file 
appears in the Attachments list box in the Compose window.

Note:    If you want to change or delete the attachment before you send your message, select the 
attached file in the Attachments list box to display the Attachment dialog box, which you can use to 
change or delete the attachment.

6. If you want to append a signature to the message that is not your default signature, select it from the 
Signatures list box.

Note:    You can define and edit signatures by choosing Signatures from the Tools menu.

7. If you want to change any of the compose option settings (such as the message priority or the blind 
carbon copy (Bcc:) address) for this message before sending it, choose Options to display the Local 
Compose Options dialog box.

Note:    The Local Compose Options dialog box overrides your default compose settings only for the 
current message.

8. When you are ready to send the message, choose Send.
--or--
To close the currently selected Compose window without sending the message, either double-click the
control box at the top left-hand corner of the window, or click the control box to display the Windows 
control menu, then choose Close.

Note:    If a name you select from the address book for a recipient header (To: or Cc:) contains one or 
more special characters, such as a pair of parentheses ( ) or a dot (.), that part of the name may be 
placed between double quotation marks when your message is sent. For example, if you select the name 
Jane A. Smith, the name may appear in the message headers of your sent message as Jane "A." 
Smith.

To change the Compose window font



Choose Set Font from the Settings menu to display the Windows Font dialog box, where you can change 
the font used to display a message in the currently selected Compose window.

Related Topics
Changing or Deleting an Attachment Before Sending a Message
Correcting the Spelling of Your Messages
Queueing and Delivering Messages While in Offline Mode
Resolving Addresses
Sending Mail from MAPI-Aware Applications
Sending a Message
Setting Compose Options
Setting Local Compose Options
Using the Address Book to Enter Recipients



Using the Address Book Dialog Box

Mail OnNet provides an address book to store the names and electronic mail (e-mail) addresses of 
yourself and your correspondents. You can use the Address Book dialog box to add, remove, change, or 
search for address book entries.

To open the Address Book dialog box, choose Address Book from the Tools menu.

Each entry in the address book has two parts: a display name (which appears in the Display Name box) 
and an e-mail address (which appears in the E-mail Address box). To make changes to the address book,
use the Address Book dialog box:

Choose this button To do this
Cancel Cancel making any changes.

Delete Remove the selected address book entry.

Edit Change the selected address book entry

Find Search for an entry in the address book when you have a large address book 
and you need to find a particular name.

New Add a new entry to the address book. 

Note: You can also configure Mail OnNet to add entries to the address book 
automatically.

OK Confirm your changes and return to the previous window.

Related Topics
Adding to the Address Book
Creating a Distribution List
Editing the Address Book
Editing a Distribution List
Resolving Addresses
Searching the Address Book
Sending Mail from MAPI-Aware Applications
Using the Address Book to Enter Recipients



Using the Address Book to Enter Recipients

Mail OnNet provides an address book to store the names and e-mail addresses of yourself and your 
correspondents. You can use the address book to fill in the recipient headers (To: and Cc:) of your 
messages in Mail OnNet and MAPI-aware applications.

To use the address book to enter recipients
1. Display a Compose window in Mail OnNet, then choose Address.

--or--
Choose Send from the File menu of the MAPI-aware application to display the Send Note dialog box, 
then choose Address.

The Address Book dialog box appears.

2. From the Display Name box, select the name you want to put into the To: header, then choose Add To:
to add the name to the To: list. The name you select appears in the list box below the Add To: button, 
which displays what you have chosen so far. Repeat this step to add other names to the To: list.

3. From the Display Name box, select the name you want to put into the Cc: header, then choose Add 
CC: to add the name to the Cc: list. The name you select appears in the list box below the Add CC: 
button, which displays what you have chosen so far. Repeat this step to add other names to the Cc: 
list.

4. If you are ready to return to the message you are composing, choose OK to accept the selections you 
have made and return to the Compose window or Send Note window.
--or--
Choose Remove to delete a name from the To: or Cc: lists, then choose OK to accept the remaining 
selections and return to the Compose window or Send Note window.

Note:    If a name you select from the address book for a recipient header (To: or Cc:) contains one or 
more special characters, such as a pair of parentheses ( ) or a dot (.), that part of the name may be 
placed between double quotation marks when your message is sent. For example, if you select the name 
Jane A. Smith, the name may appear in the message headers of your sent message as Jane A. 
Smith.

To edit an address book entry
To make changes to the address book entries before selecting any of them, use the buttons available in 
the Address Book dialog box:

Choose this button To do this
Cancel Cancel making any changes or selections.

Delete Remove the selected address book entry.

Edit Change the selected address book entry

Find Search for an entry in the address book when you need to find a particular name.

New Add a new entry to the address book.

Related Topics
Adding to the Address Book
Creating a Distribution List
Editing the Address Book
Editing a Distribution List
Resolving Addresses
Searching the Address Book



Sending Mail from MAPI-Aware Applications
Using the Address Book Dialog Box



Resolving Addresses

If you enter a name in the text boxes of the To:, Cc:, or Bcc: message headers, Mail OnNet uses the 
address book to resolve the e-mail address that corresponds to the name before sending the message to 
the mail server. If Mail OnNet does not find a unique or exact match for a name that you have provided in 
the message headers, you will be prompted to choose or specify an address to resolve it.

Partial Address Matching
If you have display names in the address book that are similar or exactly the same, but they have different
e-mail addresses, Mail OnNet prompts you to indicate which address you want to use by displaying the 
Select Match for Name dialog box. 

For example, if you type john into the To: box, and you have the following names in the address book: 
John Doe, John Jones, and John Smith, the Select Match for Name dialog box appears and 
prompts you to select one of these three entries, which are listed in its Select E-mail Address box.

If you select an address and choose OK, the message is sent to the address you selected. 

If you choose Cancel, the message is not sent; instead, Mail OnNet redisplays the Compose Window or 
Send Note window containing the message, where you can edit the name or address in the headers 
before trying to re-send the message.

No Address Matching
If a name you entered into the To:, Cc:, or Bcc: boxes is not in the address book before Mail OnNet sends
the message to the mail server, the Name Not Found in Address Book dialog box is displayed. The Name 
Not Found in Address Book dialog box prompts you to choose one of three actions:

Choose this To do this
Add Name The name that is displayed in the Name box and the e-mail address that is 

displayed in the Address box will become an entry in the address book before the
message is sent to that name and address. Note that if its address is unknown, 
Mail OnNet enters the name into both the Name and the Address boxes. You can
edit the text in both boxes to correct any inaccuracies.

Send Now Send the message using the displayed name and address, but without adding 
them as an entry into the address book. You can edit the text in both boxes to 
correct any inaccuracies.

Cancel Cancel sending the message and return to the Compose window so that you can 
re-enter the name or address in the message headers before proceeding to send
the message.

Related Topics
Adding to the Address Book
Composing a Message
Creating a Distribution List
Editing the Address Book
Editing a Distribution List
Searching the Address Book
Using the Address Book Dialog Box
Using the Address Book to Enter Recipients



Adding an Attachment to a Message

If you want to send large files or complex ones, such as those containing graphics, spreadsheets, or word
processing documents, you can send them as attachments to messages.

To send a file as an attachment to a message
1. In the Compose window of the message, choose the Attach button to display the Windows Open 

dialog box.

2. Use the Windows Open dialog box to select the file you want to attach to the message, then choose 
OK. You can attach more than one file to a message.

If you want to change or delete the attachment, select the attached file in the Attachments list box to 
display the Attachment dialog box, which you can use to change or delete the attachment.

3. When you are ready to send the message with its attachment, choose the Send button, or choose 
Send from the Message menu.

Related Topics
Changing or Deleting an Attachment Before Sending a Message
Composing a Message



Adding a Signature to a Message

Most Mail OnNet users create several signatures to use for different types of messages; for example, you 
may want to use one signature for personal messages and another for professional messages.

To append a signature to a message
1. Open a Compose Window to compose a message.

2. If you have set a default signature, it is currently selected, but you can select any signature listed in 
the Signatures list box.
--or--
Select [None] if you do not want any signature appended to the message.

Note:    If you do not yet have any signatures to choose from in the Signature list box, choose 
Signature from the Tools menu to create a signature.

Related Topic
Managing Signatures



Sending Mail from MAPI-Aware Applications

You can use Mail OnNet to send mail from other applications, provided that those applications are MAPI-
aware. If Mail OnNet is installed on your system and you start a MAPI-aware application, the Send 
command is added to the File menu of the application. You can use the Send command to send the 
currently open file or document in a mail message.

Applications can vary in how they use MAPI. Some applications send messages in the body of a MAPI 
message, while others send them as an attachment. Some applications give you a choice between these 
approaches, while others choose for you which method to use depending on the circumstances, such as 
sending saved documents as attachments and sending unsaved documents in the body of a MAPI 
message. Refer to the documentation for the application, or ask your application vendor for more 
information about how it sends messages.

To send a message from a MAPI-aware application
1. Choose Send from the File menu of the application to open a Send Note window.

2. Type the names or addresses of your recipients into the To: and Cc: boxes, using a semicolon (;) to 
separate the different addresses.
--or--
Choose Address if you want to use the address book to help you enter the correct addresses.

3. In the Bcc: box, type the names or addresses of those recipients who will receive a blind carbon copy 
of the message. When the message is received, Bcc recipients will not appear in the header 
information.

4. In the Subject: box, type a short description of the message contents.

5. Move the cursor to the message text box below the message header boxes, then type your message.

6. If you want to attach a file to the message, choose Attach. The Windows Open dialog box appears. 
Select the file you want to attach to the message, then choose OK. The filename appears in the 
Attachments list box. You can attach more than one file to a message.

Note:    If you want to change or delete the attachment before you send your message, select the 
attached file in the Attachments list box to display the Attachment dialog box, which you can use to 
change or delete the attachment.

7. When you are ready to send the message, choose Send.
--or--
Choose Cancel to close the window without sending the message.

Related Topics
Resolving Addresses
Searching the Address Book
Using the Address Book to Enter Recipients



Using a Form as a Message Template

If you frequently send messages that usually have the same content or structure, such as an expenses 
claim to your corporate home office or an agenda for a regular meeting, you can create a form and use it 
as a template to make such tasks more efficient. Once you have created a form, you can use it over and 
over again as a message template.

To use a form
1. Choose Forms from the Tools menu to display the Select a Form dialog box.

2. Select the form that you want to use from the displayed list of forms.

3. Choose the Use button to open a new Compose window, which uses the form you just selected as its 
template.

Related Topic
Managing Forms



Setting Local Compose Options

Choose the Options button in the Compose window to display the Local Compose Options dialog box. 
When the dialog box opens, it shows the current default settings for the compose options. Changing the 
settings in this dialog box overrides the default compose settings only for the message you are currently 
composing. You can change the default settings for all Compose windows by using the Compose Options 
dialog box.

A major difference between the default Compose Options dialog box and the Local Compose Options 
dialog box is that there is no Use Word Wrap selection in the Local Compose Options dialog box. If you 
want to use the Word Wrap feature, and it is not set in the default Compose Options dialog box, choose 
Word Wrap from the View menu.

To set local compose options
Select the options that you want to set in the Local Compose Options dialog box, then choose OK to 
return to the Compose window.

--or--
Choose Cancel to return to the Compose window without making any changes.

Select this option To do this
Urgent, Normal, or Low Priority

Change the priority of a message. These settings have no effect on how long it 
takes a message to reach its destination. On mail systems supporting priorities, 
the priority will be shown for the message according to how that mail system 
represents message priority information. 

For example, in Mail OnNet, the priority of a received, unread message is shown 
in a message list window by the color of the message icons: red (with 
exclamation point) represents urgent priority; yellow represents normal priority; 
and light blue represents low priority.

Delivery Receipt Receive notification that the message has arrived at its destination. If you receive
a delivery receipt message, you can be certain that the message has been 
received by the host system of the recipient. Only some systems will respond to a
request for a delivery receipt; therefore, if you fail to get a delivery receipt, do not 
assume that your message was not received.

Read Receipt Receive notification that your message has been read at its destination. If you 
receive a read receipt message, you can be certain that the recipient has read 
your message. Not all mail systems or recipients will respond to a request for a 
read receipt; therefore, if the recipients system fails to send back a read receipt, 
do not assume that your message has not been read. Mail OnNet can receive 
read receipts from other mail systems, but does not send read receipts.

Fixed Size for Message Input N Characters

Sets each line of text in the message body to be no longer than the number of 
characters specified. 70 characters is the default and is suitable for most mail 
systems that receive your messages. You must specify at least 25 characters for 
this option.

Force Hard Returns Replace the soft returns (put in by Mail OnNet to display the message within the 
width of a Compose window) by hard returns when the message is transmitted. If
this setting is used, the message when sent will contain a carriage return 
wherever a line of text reached the right-hand Compose window boundary and 
was forced to continue on the next line. 



This setting retains the appearance of the message as it was displayed in the 
Compose window, so that the mail system of your recipient displays the lines of 
text in the received message body as they once were in the Compose window. If 
the formatting of your message is important, for example if it has tables of 
numbers, and you want the receiver of your message to see exactly what you 
see in the Compose window, either select Force Hard Returns, or put in carriage 
returns manually.

Close Compose Window

Close the Compose window automatically after you have sent the message.

Save to Folder Automatically save a copy of messages you send automatically saved to a folder.
When you select this option, Mail OnNet displays the Select Folder dialog box to 
let you select the folder. By default, the Sent folder is used.

Bcc In this box, type the names or addresses to which you want to send blind carbon 
copies. Recipients who are on the Bcc list will be sent a copy of the message, but
their addresses will not appear in the message headers.

Reply To In this box, type your name or e-mail address. Each time that you send a 
message, this field appears in the message headers to tell your recipients to 
which name or address they should reply.

Related Topics
Composing a Message
Setting Compose Options



Display Name
The display name in the address book is a full name or username of a recipient, an alias for a person or 
group, or an address. Mail OnNet associates the display name with a fully qualified e-mail address, which 
together form an entry in the address book. Mail OnNet lets you use the display names in your message 
headers; when you send a message, Mail OnNet resolves the names with e-mail addresses before 
sending the message to the mail server.



E-mail Address
An e-mail address is a fully qualified electronic mail address that can be used to send mail successfully to
the person who has been assigned the address by an Internet service provider or network system 
administrator. In the address book, the e-mail address is associated by Mail OnNet with a full name, 
username, alias, or address that appears in the Display Name box. Together, the associated pair form an 
address book entry.



MAPI
The standard Messaging Application Programming Interface (MAPI) defined by Microsoft Corporation. 
Any MAPI-aware application can send messages by means of a MAPI-based messaging system such as 
Mail OnNet.



Signature
A signature usually contains information that you often want to append to the end of your messages. For 
example, a signature can contain such information about yourself as the company you work for, your job 
title, office address, e-mail address, and telephone and facsimile machine numbers. You can use different
signatures for different purposes; for example, one signature may be used for personal correspondence 
and another for professional purposes.



Checking for New Mail

Mail OnNet will check for new mail on your mail server when you choose Check Mail from the File menu, 
toolbar, or Windows control menu of the minimized Mail OnNet icon. The amount of time it takes for Mail 
OnNet to check for and retrieve new messages depends upon both the size of the messages and the 
other tasks scheduled to be done by Windows at the time that the retrieval of new mail takes place.
You can set up Mail OnNet so that it requests mail from the mail server at regular intervals if, when 
configuring Mail OnNet for your use, you select Check for New Mail Every N Minutes option in the POP2 
or POP3 Retrieve Mail Settings dialog box. (To change your Mail OnNet configuration, choose Mail 
Configuration from the Settings menu.)
Note:    If you specify zero as the value of the Check for New Mail Every N Minutes option, Mail OnNet will
not check automatically for new mail at regular intervals.
Mail OnNet downloads all new mail to the message store on your PC. In the message store, all new mail 
arrives automatically in the In-Tray folder, unless you have set up an automatic task to move mail to a 
different folder. (To create an automatic task, choose Tasks from the Tools menu.)
When new mail arrives, the minimized Mail OnNet icon changes to indicate that new mail is waiting for 
you. If the Mail OnNet main window is open, the Check Mail icon on the toolbar changes to tell you that 
mail has arrived. If you selected Use Animation, Receiving Mail in the User Preferences dialog box, 
animation displays on your screen when new mail arrives.

Related Topics
Reading a Message
Receiving Messages While in Offline Mode
Viewing an Attachment



Reading a Message

A Message List window displays all of the messages in a folder, including messages or copies of 
messages that you may have sent yourself. If you open a Message List window for the Sent folder, it 
contains a copy of any messages you have sent.
Mail OnNet retrieves all new mail from the mail server to the message store on your PC. Inside the 
message store, all new mail arrives automatically in the In-Tray folder, unless you have set up an 
automatic task to move mail to a different folder. (To create an automatic task, choose Tasks from the 
Tools menu.)
In Mail OnNet, the priority of a received, unread message is shown in a message list window by the color 
of the message icons: red (with exclamation point) represents urgent priority; yellow represents normal 
priority; and light blue represents low priority.

To read your messages
1. In the Message Store window, select the folder, such as the In-Tray folder, whose messages you want 

to read. Open a Message List window for the folder, either by choosing Open from the Folders menu, 
selecting the folder icon in the Message Store window with your cursor and pressing ENTER, or double-
clicking the folder icon in the Message Store window.

2. Select the message in the currently open Message List window. To read the message, choose Read 
from the Message menu, or double-click the message in the Message List window. A Read window 
then displays.
The amount of information shown at the top of the Read window depends on how you have set the 
Header options in the Read Options dialog box.
The main area of the window contains the body of the message. If the message is too wide to fit in the 
window, you can use the horizontal scroll bar to scroll the message in the window, or you can select 
Use Word Wrap in Read Window in the Read Options dialog box so that the message text wraps to 
the next line when the line reaches the edge of the window.

3. To view an attachment, select an attachment from the Attachments list box to display the Attachment 
dialog box.

4. To read the next or previous message in the message list of the folder, choose Next or Previous from 
the View menu or from the toolbar.

5. To close the currently selected Read window, either double-click the close box, or click the Windows 
control box to display the Windows Control menu, then choose Close.

Note:    When reading a message, you can select and copy text in the message headers or the message 
body, but you cannot cut, delete, or edit it unless you forward or reply to the message (and include the 
message in your reply).

Related Topics
Checking for New Mail
Deleting a Message
Forwarding a Message
Organizing Your Messages into Folders
Receiving Messages While in Offline Mode
Replying to a Message
Printing a Message
Saving a Message
Saving an Attachment
Viewing an Attachment



Viewing an Attachment

To view an attachment or to save the attachment to a file, double-click the name of the attachment to 
select it from the Attachments list box in the Read window. When you select the attachment, the KEYview 
application, which is the default viewer for Mail OnNet, starts and displays the attached file.
If KEYview cannot view the file because it does not recognize the file type, you can use KEYview to 
browse through your directories to find an executable file for the application you want to use to view the 
attachment.
Note:    Refer to the KEYview online help for more information about KEYview.
If you do not have KEYview or any other viewer application in use as your default viewer, selecting an 
attachment in the Attachments list box will display the Mail OnNet Attachment dialog box.

Related Topics
Reading a Message
Saving an Attachment



Mail OnNet Attachment Dialog Box

The Mail OnNet Attachment dialog box appears when you select an attachment from the Attachments list 
box in a Read window.
Caution:    Do not try to view a file with the filename extension .EXE.

This item Displays
Type The type of file attached to the message, as indicated by filename extension.
Name The name of the attached file.
View Using The name and path of the application in which the attached file was written, 

provided that you have the same application installed on your computer, and the 
attachment type is recognized by Windows as being associated with that 
application in the Windows registration database (refer to your Windows 
documentation for information).
If the file type is not recognized, the View Using box will show the viewing 
application as [NONE].To use an application to view an attachment that does not 
have a recognized file type, or if you want to view a recognized attachment using 
a different application, enter the full path and filename of the application in the 
View Using box. You can determine which application should be used for viewing 
a particular file type by using the Associate command in the Windows File 
Manager. Refer to your Windows documentation for more information.

Icon The icon of the application in which the attached file was written, provided that 
you have the same application installed on your computer and its type is 
associated with that application in the Windows registration database (refer to 
your Windows documentation for information). If the file type is not recognized, 
Mail OnNet displays a "binary file" icon:    

Choose this button To do this
View Open the application in the View Using box with the attached file loaded as a 

read-only document. You can only save, not view, an attachment containing a file 
with the .EXE, .COM, or .BAT extension.
Note:    When the attachment is opened as a read-only file, you will not be able to
edit it in the viewing application, although you may be able to save a copy under 
another name and then edit it. Alternatively, you can save the attachment to a file 
by choosing Save.

Save Save an attachment to a file by using the Windows Save As dialog box.
Note:    If you save    an attachment that contains a file with the filename 
extension .EXE, .COM, or .BAT, make certain that you run a virus checker 
program on the file before using it.

Cancel Dismiss this dialog box.



Saving an Attachment

The method for saving an attachment that you are viewing varies, depending on whether or not you are 
using the KEYview document viewer, another document viewer, or the Mail OnNet Attachment dialog box.
If you are using an application other than KEYview or Mail OnNet to save the attachment, refer to that 
application's documentation for instructions on saving an attachment.

To save an attachment in KEYview
1. Select the name of the attachment from the Attachments list box in the Read window. When you select

the attachment, the KEYview application, which is the default viewer for Mail OnNet, starts and 
displays the attached file.

2. Choose Save As from the KEYview File menu. The Select Target Filename dialog box appears.
--or--
Choose Save As from the KEYview toolbar.

3. In the Select Target Filename dialog box, specify the name of the file in the File Name box.
4. In the Directories list box, select the directory to which the file will be saved.
5. In the Drives list box, select the drive to which the file will be saved.
6. If you want to convert the file to a different format (such as text or Microsoft Word for Windows), select 

the format from the list of available formats in the Convert to box, then choose OK to save the 
attachment.
--or--
Choose cancel to return to the main KEYview window without saving the attachment to a file.

Note:    Refer to the KEYview online help for more information about KEYview. If you save    an attachment
that contains a file with the filename extension .EXE, .COM, or .BAT, make certain that you run a virus 
checker program on the file before using it.

To save an attachment if you are using the Mail OnNet Attachment dialog box
If you do not have KEYview or any other viewer application in use as your default viewer, selecting an 
attachment in the Attachments list box will display the Mail OnNet Attachment dialog box.
1. Select the attachment in the Attachments list box in the Read window.
2. Choose Save in the Attachment dialog box to display the Windows Save As dialog box.
3. In the File Name box, type the name of the file to which the attachment will be saved.
4. In the Directories list box, select the directory to which the file will be saved.
5. In the Save File as Type box, select the extension for the filename that indicates the type of file.
6. In the Drives list box, select the drive to which the file will be saved.
7. Choose OK to save the attachment.

--or--
Choose Cancel to return to the Attachment dialog box without saving the attachment to a file.

Note:    If you save    an attachment that contains a file with the filename extension .EXE, .COM, or .BAT, 
make certain that you run a virus checker program on the file before using it.

Related Topics
Reading a Message
Viewing an Attachment



Message List Windows

You can open the message list window of a folder from the Message Store window to display the list of 
messages held in a folder. The message list displays such information about a message as the sender of 
the message, the subject, and the date and time it was sent. 
Messages that you have already read are not preceded by an icon. Messages that you have not read are 
marked with a closed envelope. The color of the envelope icon indicates the message priority. In Mail 
OnNet, priority is shown by the color of the message icons: red (with exclamation point) represents urgent
priority; yellow represents normal priority; and light blue represents low priority.
Messages that you have sent (such as those that appear in your default Sent folder) will appear on lists 
with an icon representing a paper sheet of writing.
You can open a Read window to read the message.
You can select the messages to be forwarded, read, or replied to by choosing Forward, Read, or Reply To
from the Message menu.
You can also use drag and drop to move or copy a message from one message list window to another, or 
to a different folder in the Message Store window.

Related Topics
The Message Store Window
Reading a Message



The Message Store Window

The Message Store window lists the folders holding messages in the message store. Your message store
must contain both an In-Tray and an Out-Tray folder. Initially there will also be a Sent folder, but you can 
delete or rename it. 
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.
You can use the New, Copy, Move, Rename, and Delete commands on the Folders menu to organize 
your message store. As a quick alternative, you can drag and drop folders.
You can also open a Message List windowto view a list of the messages in a folder.
The Message Store window shows you which folders are open by changing the folder icon from closed to 
open. Closing the Message List window changes the icon back to the closed folder image, unless there 
are unread messages in the folder; in that case, an image of an unopened envelope overlaps the folder 
icon.

Related Topics
Message List Windows
Reading a Message



Drag and Drop

You can move a folder from one position in the list of folders in the Message Store window to another 
position with your mouse. Use the drag and drop method to move or copy a message manually (that is, 
not by using an automatic task) from one Message List window to another or from a message list to a 
folder in the message store.
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

To drag and drop a folder
1. Position the cursor over the folder you want to move.
2. Press and hold the SHIFT key.
3. Press and hold the left mouse button and drag the folder into its new position.
4. Release the mouse button first, then the SHIFT key, to drop the folder into its new position.

To copy a folder from one position in the folder list to another 
Drag the folder to the position where you want a copy of the folder while holding down the CTRL key.
The effect of dragging without holding the SHIFT or CTRL key depends on whether or not the Confirm Drag 
Operation option is selected in the User Preferences dialog box. If the option is selected, the effect of 
dragging is to move the folder to its new position; if the option is not selected, the effect is to copy the 
folder to its new position.



In-Tray Folder
The In-Tray folder holds all new mail received from the mail server. You can create tasks that will move 
new mail to other folders automatically.



Out-Tray Folder
The Out-Tray folder holds mail temporarily during the time between the sending of a message and the 
actual delivering of it by Mail OnNet to the mail server. 



Sent Folder
The Sent folder is the default folder used to hold messages after you have sent them and Mail OnNet has 
delivered them to the mail server. Unlike a carbon copy (Cc) of a message, a Sent folder copy is saved 
directly to the message store and does not travel to the mail server and back.



Forwarding a Message

You can forward a message if you first select the message in a Message List window or display the 
message in a Read window.
The format of your forwarded message is controlled by settings made in the Forward Options dialog box.

To forward a message and its attachments
1. Select the message in a Message List window or, if it is already open in a Read window, select the 

Read window.
2. Choose Forward from the Message menu to open a Compose window that contains the message to 

be forwarded. Mail OnNet puts the subject of the original message into the Subject: field, which you 
can edit if you wish.

3. In the To: field, type the names or electronic mail (e-mail) addresses of those to whom you will forward 
the message. Use a semicolon (;) to separate addresses.

4. In the Cc: fields, enter the addresses of those to whom you will forward copies of the message. Use a 
semicolon to separate the e-mail addresses.

5. The files attached to the original message and any others you attach are shown in the Attachments list
box. If you want to delete an attachment or change the way an attachment is sent, select the 
attachment from the Attachments list box to display the Attachment dialog box.

6. The body of the Compose window contains the body of the message being forwarded with your 
Forwarding Begin With string, Forwarding End With string, and Forwarding Indent With string (if set) 
added where appropriate. To add your own comments to the message, or edit the text of the message,
you can use any of the editing and menu operations that can be applied to messages in a Compose 
window.    
--or--
Choose Import Text from the Edit menu to display the Windows Open dialog box. Browse for and 
choose the text file that you want to insert into the message body at the position of the cursor.

7. When you have finished, choose Send to forward the message.

Related Topics
Composing a Message
Reading a Message
Replying to a Message
Sending a Message
Setting Options for Forwarding Messages



Replying to a Message

You can reply to a message if you first select the message in a Message List window or display the 
message in a Read window.
Note: The format of your reply can be controlled by settings made in the Reply Options dialog box.

To reply to a message
1. Select the message in a Message List window or, if it already appears in a Read window, select the 

Read window.
2. Choose the Reply button from the toolbar to open a Compose window. If you use the reply button, you 

are not presented with the Reply To submenu; instead, the option set in the Reply Options dialog box 
is used as a default.
--or--
Choose Reply from the Message menu, then select one of the following options from the Reply To 
submenu:
Sender. Sends the reply only to the original sender.
Sender--Include Message. Sends the reply only to the original sender, including the original 
message in the reply.
All. Sends the reply to the sender and all recipients listed in the Cc: list.
All--Include Message. Sends the reply to the sender and all recipients listed in the Cc: list, 
including the original message in the reply.

3. Mail OnNet puts the address of the sender in the To: field. If you want to add names or addresses to 
the To: field, separate them with a semicolon (;). If you have selected one of the Reply to All options, 
the Cc: field contains the addresses of all those on the original Cc: list. You can edit this list.

4. Files attached to the original message will not be attached to the reply even if you have selected an 
Include Message option. If you want to add an attachment of your own to the reply, choose Attach to 
display the Attachment dialog box.

5. If you have chosen an Include Message reply option, the body of the Compose window contains the 
body of the original message with your Reply Begin With string, Reply End With string, and Reply 
Indent string (if set) added where appropriate. You may edit the message.
--or--
Choose Import Text from the Edit menu to display the Windows Open dialog box. Browse for and 
choose the text file that you want to insert into the message body at the position of the cursor.
When you are finished, choose Send.

Related Topics
Changing or Deleting an Attachment Before Sending a Message
Composing a Message
Forwarding a Message
Reading a Message
Sending a Message
Setting Options for Replying to Messages



Saving a Message, Signature, or Form to a Text File

You can use the Windows Save As dialog box to save any message currently displayed in a Read or 
Compose window, or the currently displayed signature or form to a text file.
To determine whether or not the text files should include message header information as well as the 
message body, select the Include Message Header Saving to File option from the User Preferences 
dialog box. To determine how much header information should be included, select one of the message 
header options from the Read Options dialog box.

To save a message, signature, or form to a text file
1. To save a currently displayed message, signature, or form, choose Save As from the File menu.

--or--
Choose Save to File from the toolbar.
--or--
Choose Save to File from the Message menu to save a currently displayed message.

2. The Windows Save As dialog box appears. Specify the pathname and filename into which you want to 
save the message, signature, or form, then choose OK. Once you have saved it to a text file, you can 
import the file into other applications, such as a word processor, desktop publishing package, or 
spreadsheet.
Note: You cannot use the Save As option to save attachments. Use the Save button on the 
Attachment dialog box to save an attachment.

To save several messages in a Message List window to a single text file
1. Select the first message you want to save in the Message List window.
2. Press and hold the CTRL key as you select each of the other messages.

--or--
If you want to extend the selection to include a number of adjacent messages, select the first message
you want in the range, press and hold the SHIFT key, then select the message in the list that is at the 
other end of the range. All messages in between the two will also be selected.

3. Choose Save As from the File menu to display a standard Windows Save As dialog box. Proceed as 
for a single message.

Related Topics
Saving to a Folder
Saving an Attachment



Saving a Message to a Folder

To save one or more messages to a folder
1. Select the message in a Message List window or an open Read window. 

If you want to copy more than one message in a Message List window, press and hold CTRL as you 
select each of the messages.
--or--
If you want to extend the selection to include a number of adjacent messages, select the first message
you want in the range, press and hold the SHIFT key, then select the message in the list that is at the 
other end of the range. All messages in between the two will also be selected.

2. Choose Save to Folder from the Message menu to display the Save to Folder dialog box.
3. In the folders list box, select the target folder to which you will copy or move the messages.
4. Select Close After Filing if you are saving the message from an open Read window and want to close 

that window once you have saved the message.
5. Select Move Messages if you want to delete the messages from their current folder after they are 

saved into the new folder.
6. Choose OK to save the message(s) to the selected folder.
Note: You can also use drag and drop to move or copy messages between folders.

Related Topics
Saving to a File
Saving an Attachment



Changing or Deleting an Attachment Before You Send a Message

Use the Attachment dialog box either to change how Mail OnNet sends the attachment with the message,
or to specify a different attachment, or to remove an attachment before sending the message.

To specify a different attachment or to specify how to send it
1. To display the Attachment dialog box, use your mouse to choose the attached file in the Attachments 

list box of the Compose window.
2. The File box in the Attachment dialog box displays the name of the attached file. To change the file, 

type the name of the file you want to attach in the File box.
3. Select one of the following attachment options:

Include Data in Message. Select this option if you want the contents of the file to be sent with 
the message.
Just Send Filename. Select this option if you want to send only the filename, not the contents of 
the file. You might want to use this option if you are sending the message locally to someone who also 
has direct or network access to the file's location.
Automatic. Select this option if you want Mail OnNet to determine whether to send the contents of 
the file or just the filename, depending on the location of the file and the recipient of the message.

4. Choose OK to return to the Compose window.
--or--
Choose Cancel to return to the Compose window without making any changes.

To delete an attachment before sending the message
1. To display the Attachment dialog box, use your mouse to choose the attached file in the Attachments 

list box of the Compose window.
2. In the Attachment dialog box, choose Delete. A confirmation dialog box appears.
3. Choose OK to remove the attachment from your message and return to the Compose window.

--or--
Choose Cancel to return to the Compose window without deleting the attachment.

Related Topics
Composing a Message
Saving an Attachment
Sending a Message
Viewing an Attachment



Printing a Message, Signature, or Form

To print the currently displayed message, signature, or form 
Choose Print from the File menu.
--or--
Choose Print from the toolbar.
Mail OnNet displays the Windows Print dialog box, which displays the options for your selected printer. 
The settings you select from the Print dialog box will depend on the printer you are using.

To print the message header above the message body
1. Before you print the message, choose Preferences from the Settings menu to display the User 

Preferences dialog box. 
2. Select the Include Message Header--Printing option. 

To define a header and footer for each page that you print
Choose Page Setup from the File menu.
You will not be able to see the effects of changing the header and footer in the message displayed in the 
currently selected window, but you can see what the message will look like by choosing Print Preview 
from the File menu.

To change the font used to print your message
Choose Set Printer Font from the View menu. 
You will not be able to see the effects of changing the printer font in the message displayed in the 
currently selected window, but you can see what the message will look like by choosing Print Preview 
from the File menu.

To print the message as it appears on your screen
Choose Mirror Display Font from the View menu.

To change the setup of your printer or to select a different printer
Choose Print Setup from the File menu.

Related Topics
Page Setup
Setting the Printer Font

Mirroring the Display Font



Configuring Offline Mode as the Default Mode

To configure offline mode

1. From the Settings menu of the Mail OnNet main window, choose Mail Configuration.
2. In the User Information dialog box, choose the Start Mail In Offline Mode option.
3. Choose OK until you have finished displaying and closing the Mail Configuration dialog boxes and 

return to the Mail OnNet main window.
4. Restart Mail OnNet for your change to take effect.

Related Topics
Queueing and Delivering Messages While in Offline Mode
Receiving Messages While in Offline Mode
Switching Between Online and Offline Modes



Queueing and Delivering Messages While in Offline Mode

To put messages in the Out-Tray folder queue

1. If you have not already done so, make certain that you are using Mail OnNet in Offline mode. The 
Offline Mode button on the toolbar is selected (depressed) when you are in this mode.

2. From the Message menu of the Mail OnNet main window, choose Compose Message to open a 
Compose window.
-or-
Choose Compose on the toolbar.

3. In the Compose window, prepare your message, then choose the Queue Mail button. Mail OnNet puts 
the message in the Out-Tray folder to wait for delivery to the mail server.
-or-
When ready, choose Queue from the Message menu in the Mail OnNet main window.

Note:    If you choose Deliver Mail on the toolbar, your message is both queued in the Out-Tray folder 
and delivered to the mail server, along with every other message queued in the Out-Tray folder.

To deliver queued messages to the mail server

While you are using Mail OnNet in Offline mode, in the Mail OnNet main window, choose Deliver Mail on 
the toolbar or choose Deliver from the Message menu. Mail OnNet connects with your mail server to send
the messages that are queued in the Out-Tray folder.

Related Topics
Configuring Offline Mode as the Default Mode
Receiving Messages While in Offline Mode
Switching Between Online and Offline Modes



Receiving Messages While in Offline Mode

When you are using Mail OnNet in Offline mode, choose Check Mail from the toolbar or FIle menu to 
receive new mail.

Related Topics
Configuring Offline Mode as the Default Mode
Queueing and Delivering Messages While in Offline Mode
Switching Between Online and Offline Modes



Switching Between Online and Offline Modes

To switch to Offline mode, choose Offline Mode on the toolbar or Settings menu.
To switch to Online mode, choose Online Mode on the toolbar or Settings menu.
Your chosen mode remains in effect until you change it.

Related Topics
Configuring Offline Mode as the Default Mode
Queueing and Delivering Messages While in Offline Mode
Receiving Messages While in Offline Mode



Adding to the Address Book

You can add entries to the address book in two ways:

· Automatically: Using this method, Mail OnNet inserts into your address book any names and 
addresses that it finds in your incoming messages. You must configure Mail OnNet to add to the 
address book automatically. If you allow the address book to be added to automatically, you must 
remove unwanted entries periodically. Otherwise, the address book may become larger than you 
need.

· Manually: You can use this method regardless of whether or not you are using the automatic build 
method. To enter a new entry manually, enter the new information in the New Address Book Entry 
dialog box.

Note:    You can have more than one entry for each person in your address book.

To add to the address book automatically
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. After selecting POP2 as your mail retrieval protocol in the User 
Information dialog box, choose OK to display the POP2 or the POP3 Retrieve Mail Settings dialog box.

2. Select the Update Address Book with New Addresses on Retrieval option, then choose OK. 

3. Choose OK until the Mail OnNet main window becomes the current window.

4. Exit from Mail OnNet, then restart it for your change to take effect.

To add to the address book manually
1. Choose Address Book from the Tools menu to display the Address Book dialog box.

2. Choose New to display the New Address Book Entry dialog box. 

3. In the Display Name box, type the name that will identify the entry of the person in the address book. 
For example, type John J. Doe, John Doe, John, jdoe, or even jdoe@xyz.com. 

4. In the E-mail Address box, type the entire electronic mail (e-mail) address of the person for his or her 
entry in the address book. For example, type jdoe@xyz.com.

5. Choose OK to return to the Address Book dialog box. The new name appears in the Display Name 
box.

--or--
Choose Cancel to return to the Address Book without adding the entry.

Related Topics
Creating a Distribution List
Editing the Address Book
Editing a Distribution List
Resolving Addresses
Searching the Address Book
Using the Address Book to Enter Recipients



Editing the Address Book

To edit an address book entry
1. Choose Address Book from the Tools menu to display the Address Book dialog box.

2. Select an entry in the Display Name box, then choose Edit from the Address Book dialog box to 
display the Edit Address Book Entry dialog box.

3. In the Display Name box, you can modify the name that will identify the person in the address book. 
For example, type John J. Doe, John Doe, John, jdoe, or even jdoe@xyz.com. 

4. In the E-mail Address box, you can modify the electronic mail (e-mail) address of the entry for that 
person in the address book. Always type the entire e-mail address. For example, type 
jdoe@xyz.com.

5. Choose OK to return to the Address Book dialog box.

--or--
Choose Cancel to return to the Address Book without making changes to the entry.

Related Topics
Adding to the Address Book
Creating a Distribution List
Editing a Distribution List
Resolving Addresses
Searching the Address Book
Using the Address Book to Enter Recipients



Setting Your Mail OnNet Preferences

Choose Preferences from the Settings menu to display the User Preferences dialog box. Use this dialog 
box to specify your preferences while using Mail OnNet.

Choose OK to return to the previously selected window and put your preferences into effect. To cancel 
making changes, choose Cancel.

Select this option To do this
Drag Default, Move Message

Drag and drop without holding the SHIFT or CTRL keys as you move messages or 
folders.

Drag Default, Copy Message

Drag and drop without holding the SHIFT or CTRL keys as you copy messages or 
folders.

Confirm Delete Mail OnNet will prompt you for confirmation when deleting a message, folder, 
form, or signature.

Confirm Drag Operations

Mail OnNet will prompt you for confirmation when you drag a folder from one 
position in the Message Store window to another.

Use Animation, Sending E-mail

Use animation to indicate that a message is being sent to the mail server.

Use Animation, Receiving E-mail

Use animation to indicate that new mail has arrived at your PC.

Include Message Header, Saving to File

Save the message header as well as the message body when you save a 
message to a text file (for example, when you choose Save As from the File 
menu).

Include Message Header, Printing

Print the message header with the message when you choose Print from the File 
menu.

Miscellaneous, Use Local Character Set Mapping

Set which character set is used when Mail OnNet displays messages in Read 
and Compose windows. If you select this option, standard US-ASCII characters 
will be mapped to local country mappings by using ISO 640.

Miscellaneous, Close at End of List When Deleting Messages

Close the Read window after you delete the last message in a message list. If 
this option is not selected, the Read window remains open, and Mail OnNet uses 
the window to display the last message available from the message list.

Related Topics
Setting Default Compose Options
Setting Forward Options
Setting Local Compose Options
Setting Read Options
Setting Reply Options





Organizing Your Messages in Folders

You can organize your messages in the message store by creating new folders to hold the messages, 
and by moving messages between folders.

Initially, the message store has the In-Tray, Out-Tray and Sent folders. These are all stored in the root 
folder of the message store, and all of these folders together constitute the folder hierarchy. You can 
create new folders to store at any level below the root folder in this hierarchy, just as you would if you 
were making a hierarchy of directories on your system by using the Windows File Manager.

When you install Mail OnNet, by default the Sent folder is used for automatically saving the messages 
you send. You can change this default so that another folder is used, or you can choose not to save sent 
messages automatically. You can also change the folder used for an individual message.

Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Related Topics
Selecting a Default Folder for Sent Messages
Creating a Folder
Moving a Folder
Copying a Folder
Deleting a Folder
Renaming a Folder
Saving to a Folder
Drag and Drop



Selecting a Folder

Use the Select Folder dialog box to select a folder to which messages will be saved.

Note:    The folder must exist before messages can be copied or moved to it.

To select a folder
In the Select Folder dialog box, select the folder from the displayed list of folders, then choose OK. The 
folder you select becomes the folder in which your messages are stored.

You cannot save messages to the In-Tray or Out-Tray folders.

To change the default folder used to save sent messages
The Sent folder is the default folder for storing copies of your sent messages. You can select a new 
default folder to store sent messages if the folder exists before you set it up as the default.

You cannot select either the In-Tray or Out-Tray folders to be the default folder for storing sent messages.

1. Choose Compose Options from the Settings menu, or choose Options from the Compose window to 
display the Default Compose Options dialog box.

2. Select the When Sending Mail, Save to Folder option. (The Sent folder is the default.) Mail OnNet 
displays the Select Folder dialog box.

3. Choose the folder from displayed list of folders, then choose OK. The folder you select becomes the 
default folder in which copies of your sent messages are stored.
--or--
Choose Cancel in the Select Folder dialog box to accept the Sent folder as the default.

4. Choose OK in the Default Compose Options dialog box to return to the Mail OnNet main window.

Note: If you do not want to save sent messages into a folder automatically, deselect Automatically Save 
to Folder in the Default Compose Options dialog box.

Related Topic
Organizing Your Messages into Folders



Managing Signatures

In the messages that you send, you are identified by the name or electronic mail (e-mail) address that 
appears in the From: message header field. To include more information about yourself in a message, 
such as the name, address, telephone number, and facsimile number of your corporation, you can 
append a signature to the message. 

You can create, choose, or delete signatures in the Select a Signature dialog box, and you can select one
to be a default signature. You may want one signature for professional e-mail, and another for personal 
mail. Mail OnNet allows you to create as many signatures as you like and select one, or none, to be your 
default signature.

Choose this button To do this
New Create a new signature.

Edit Change the selected signature.

Default Designate the selected signature as your default signature. Mail OnNet appends 
the default automatically to any messages that you send, unless you select 
another signature for the message in the Compose window or Send Note dialog 
box.

The default signature is marked with an asterisk (*) in the Signatures list box.

Delete Delete the selected signature.

If you have set the Confirm on Delete option in the User Preferences dialog box, 
Mail OnNet prompts you to confirm that you want to delete the signature.

Cancel Return to the previously selected window without making any changes.

Related Topics
Adding a Signature to a Message



Creating a Signature

To create a signature
1. Choose Signatures from the Tools menu. The Select a Signature dialog box appears.

2. Choose New to display the New Signature window. Type the text that will appear as your signature, 
then choose Save to display the Enter a Filename dialog box.

--or--
Choose Cancel to return to the Mail OnNet main window without creating a new signature.

4. In the Enter a Filename dialog box, type a name for the signature that is no more than eight (8) 
alphanumeric characters in length. Mail OnNet automatically appends the filename extension .SIG to 
each file that stores a signature. 

5. Choose OK to return to the previously active window.

To save the contents of a signature window to a text file
While you have the signature file displayed in a signature window, choose Save As from the File menu to 
save the signature to a text file.

Related Topic
Managing Signatures



Editing a Signature

To edit a signature
1. Choose Signatures from the Tools menu. The Select a Signature dialog box appears.

2. Select the signature from the list of displayed signature filenames, then choose Edit.

3. Mail OnNet displays the signature in a window, so that you can edit it. When you are finished, choose 
Save to return to the previously selected window.

--or--
Choose Cancel to return to the previous window without changing the signature.

To save the contents of a signature window to a text file
While you have the signature file displayed in a signature window, choose Save As from the File menu to 
save the signature to a text file.

Related Topic
Managing Signatures



Enter Filename - Signatures

To name a signature
In the Name box of the Enter Filename dialog box, type a filename of no more than eight (8) 
alphanumeric characters in length to name the file containing the signature, then choose OK to return to 
the previously selected window.

--or--
Choose Cancel to return to the previously selected window without creating the new signature.



Managing Forms

If you frequently send messages that usually have the same content or structure, such as an expenses 
claim to your corporate home office or an agenda for a regular meeting, you can create a form and use it 
as a template to make such tasks more efficient. Once you have created a form, you can use it over and 
over again as a message template. Choose Forms from the Tools menu to display the Select a Form 
dialog box, where you can create and manage forms.

Choose this button To do this
New Create a new template form.

When you use the resulting form, the text that you typed into the message 
header text boxes and the message body are copied into the corresponding 
fields in a new Compose window. You can edit and use this Compose window in 
the same way as any other Compose window.

Edit Change the selected form.

Use Use the selected form by opening a new Compose window based on the form.

The message headers and body of the Compose window contain the text you 
entered in the form when you created or edited it.

Delete Delete the selected form.

If you have set the Confirm on Delete option in the User Preferences dialog box, 
Mail OnNet prompts you to confirm that you want to delete the form.

Cancel Return to the previously selected window without making any changes.

Related Topic
Using a Form as a Message Template



Creating a Form

If you frequently send messages that usually have the same content or structure, such as an expenses 
claim to your corporate home office or an agenda for a regular meeting, you can create a form and use it 
as a template to make such tasks more efficient. Once you have created a form, you can use it over and 
over again as a message template.

To create a template form
1. Choose Forms from the Tools menu. The Select a Form dialog box appears.

2. Choose New to display the New Form window.

3. If the messages built using the form will always be sent to the same person, type the name or 
electronic mail (e-mail) address of that person into the To: box.

4. If you want the messages built from the form to carry the same subject description, type the subject 
into the Subject: header box.

5. If you always plan to send copies of the messages built using the form to the same people, type their 
names or addresses into the Cc: box.

6. Type any text into the main text window that you want to have in all of the messages built from this 
form, then choose Save.

Note:    You must type some text to be able to save the form.

7. In the Enter a Filename dialog box, type a name for the form that is no more than eight (8) 
alphanumeric characters in length. Mail OnNet automatically appends the filename extension .FRM to 
each form file.

8. Choose OK to return to the previously selected window.

To save the contents of a form window to a text file
While you have the form displayed in a window, choose Save As from the File menu.

Related Topic
Managing Forms



Editing a Form

If you frequently send messages that usually have the same content or structure, such as an expenses 
claim to your corporate home office or an agenda for a regular meeting, you can create a form and use it 
as a template to make such tasks more efficient. Once you have created a form, you can edit it as 
needed.

To edit a form
1. Choose Forms from the Tools menu.

2. Choose Edit in the Select a Form dialog box.

3. In the form window that appears, edit your form. When you are finished, choose OK.

To save the contents of a form window to a text file
While you have the form displayed in a window, choose Save As from the File menu.

Related Topic
Managing Forms



Enter Filename - Forms

To name a form
In the Name box of the Enter Filename dialog box, type a filename of no more than eight (8) 
alphanumeric characters in length to name the file containing the form, then choose OK to return to the 
previously selected window.

--or--
Choose Cancel to return to the previously selected window without creating the new form.



Deleting a Folder

To delete a folder and its contents (all folders and messages stored within the folder), select the folder you
want to delete, then choose Delete from the Folders menu.

If you have set the Confirm on Delete option using the User Preferences dialog box, Mail OnNet prompts 
you to confirm that you want to delete the folder and its contents.

Note:    You cannot delete the In-Tray, Out-Tray, or Sent folders.

Although you will probably be able to find and identify the directories and files used to store Mail OnNet 
folders and messages, use only the Mail OnNet commands and operations to manipulate folders and 
messages. If you use another tool, such as Windows File Manager, to manipulate your Mail OnNet folders
and messages, you can cause an error in Mail OnNet, because it keeps track of messages by storing 
additional information about them in the directory for each folder.

Related Topics
Organizing Your Messages into Folders

The Folders Menu



Creating a Distribution List

To create a distribution list
1. From the Tools menu of the Mail OnNet main window, choose Address Book to display the Address 

Book dialog box.

2. Choose New to display the New Address Book Entry dialog box.

3. In the Display Name box, type the name of the distribution list as it is to appear in the Address Book. 
For example, type Personal Staff or Project Development List.

4. In the E-mail Address box, type the e-mail address of the first distribution list member. For example, 
type johndoe@xyz.com.

5. Choose Add to add the list member's e-mail address.

6. Repeat steps 4 and 5 until all of the members' e-mail addresses have been added to the list.

7. Choose OK to return to the Address Book dialog box.

-or-
Choose Cancel to return to the Address Book dialog box without creating the distribution list.

Related Topics
Adding to the Address Book
Editing the Address Book
Editing a Distribution List
Resolving Addresses
Searching the Address Book
Using the Address Book to Enter Recipients



Editing a Distribution List

To edit a distribution list
1. From the Tools menu of the Mail OnNet main window, choose Address Book to display the Address 

Book dialog box.

2. Select the name of the distribution list from the list of address book entries, then choose Edit.

3. If you want to change the name of the list, type the new name into the Display Name box.

4. If you want to remove a member's address from the list, find and select the address in the list of 
addresses that appears below the E-mail Address box, then choose Delete.

-or-
If you want to add a member to the list, type the member's e-mail address in the E-mail Address box, 
then choose Add to add the member's e-mail address to the list.

6. Repeat step 4 until you are satisfied with your changes, then choose OK to return to the Address Book
dialog box.

-or-
Choose Cancel to return to the Address Book dialog box without saving your changes to the list.

Related Topics
Adding to the Address Book
Creating a Distribution List
Editing the Address Book
Resolving Addresses
Searching the Address Book

Using the Address Book to Enter Recipients



Converting the Format of Your Address Book

To use your current Mail OnNet 2.x address book file with Mail OnNet version 2.5, you must let Mail 
OnNet convert the address book entries to a new format. After you convert the entries, the address book 
file is renamed from 0.abc to 1.abc, and you can use the entries with Mail OnNet version 2.5 just as 
you could with earlier versions of Mail OnNet.

Choose this To do this
OK Proceed with converting the address book entries. After the conversion is 

complete, the Mail OnNet main window appears.

Cancel Cancel the address book conversion process and open the Mail OnNet main 
window. Until you convert your address book entries, you will be unable to use 
them with Mail OnNet. In addition, each time that you start the application, Mail 
OnNet will detect your address book file and redisplay the Address Book 
Conversion dialog box, prompting you to convert your address book file.

Do not display this dialog again

Cancels displaying the Address Book Conversion dialog box each time that you 
start Mail OnNet, even though you have not yet converted your address book 
entries. To display the Address Book Conversion dialog box after choosing this 
option, follow this procedure:

To redisplay the Address Book Conversion dialog box
1. From the Settings menu of the Mail OnNet main window, choose Mail Configuration.

2. In the User Information dialog box, choose the Locations button.

3. In the Locations dialog box, select the Display Convert Address Book Dialog on Next MAPI Logon 
option, then choose OK.

4. Choose OK until you have finished displaying and closing each Mail Configuration dialog box.

5. Restart Mail OnNet.



Creating a Task

You can create tasks that let you filter messages from your In-Tray folder and perform other automated 
actions on your messages. Use the New Task dialog box to create an automatic task.

To create a task
1. Choose Tasks from the Tools menu to display the Task Manager dialog box.
2. Choose New to display the New Task dialog box.
3. Select the event that runs a task.
4. Select the matching criteria that determine which messages are affected by the task.You may select 

more than one.
5. Select the action to be performed by the task. You may select more than one.
6. View your selections in the task summary, then choose OK.
7. Save the task in the Save Task dialog box.
To display the task summary on the New Task dialog box, choose Show Summary. To hide the task 
summary when it is displayed, choose Hide Summary.

Related Topics
Deleting a Task
Editing a Task
Example of Creating a Task
Managing Tasks
Saving a Task
What Are Tasks?



Example of Creating a Task

To create a task that will take out of the In-Tray folder all incoming messages that arrive from John Doe 
which contain the phrases monthly report or quarterly results, then move those messages into a folder 
named "Reports," proceed as follows.
1. Create a folder named "Reports" before you create the task that moves messages into it.
2. Choose Tasks from the Tools menu to display the Task Manager dialog box, then choose New to 

display the New Task dialog box.
3. Select New Mail in the On Event box.
4. Choose Add (next to the Match Criteria box) to display the Select a New Match dialog box. In that 

dialog box, select Sender, then choose OK.
5. In the Sender Contains dialog box, type John Doe in the Match text box, then choose Add (or press 

ENTER). John Doe appears in the Match box. Choose OK to return to the New Task dialog box.
6. Choose Add (next to the Match Criteria box) to display the Select a New Match dialog box. On that 

dialog box, select Message Text, then choose OK.
7. In the Message Text Contains dialog box, type monthly report in the Match box, then choose Add 

(or press ENTER).
8. In the Match box, type quarterly results, then choose Add (or press ENTER). 
9. If you want to match only messages that contain both phrases, select Must Match All of These Entries,

then choose OK to return to the New Task dialog box.
--or--
If you want to match messages that contain either or both of these phrases, select Must Match Any of 
These Entries, then choose OK to return to the New Task dialog box.
Note:    The And Matches option (below the Match Criteria box) is selected to indicate that each 
matching message must be sent from John Doe and the message text must contain either of the 
phrases you specified.

10.Choose Add (next to the Perform Action box) to display the Select a New Action dialog box. In that 
dialog box, select Save to Folder, then choose OK.

11.In the Specify Folder dialog box, choose Folder Name.
12.In the Select Folder dialog box, select the Reports folder, then choose OK to return to the Specify 

Folder dialog box. In the Specify Folder dialog box, choose OK to return to the New Task dialog box.
13.Review the task settings in the Task Summary box, then choose OK to display the Save Task dialog 

box.
14.In the Save Task dialog box, type a short description of the task into the Description box.
15.In the File Name box, type a filename (without the extension) for the task. You can specify a name no 

longer than eight characters. Choose OK to return to the New Task dialog box.
16.Choose Done to return to the Mail OnNet main window. The task takes effect immediately, in that the 

next time that you receive new mail, any messages from John Doe that contain the phrases "monthly 
report" or "quarterly results" will be moved into the folder named Reports.

Related Topics
Managing Tasks
What Are Tasks?
When Things Go Wrong with Mail OnNet



Selecting an Event

To determine when the task is to be run, select one of the events in the On Event box of the New Task or 
Edit Task dialog box. If you want to change the task event before saving it, select a different event in the 
On Event box. Select one of the following events from the On Event box to determine when a task is run.

This event Causes the task to run when...
Add Mail to Folder (folder) A message is added to a specified folder 
New Mail (left arrow) New mail arrives at your PC. (Default)
Submitting Mail (right arrow) You choose Send in a Compose window.
Time Period (clock) At a time or interval that you specify.
User Activated (human face) You choose Run Now in the Task Manager dialog box.
Any event (lightbulb) Active (highlighted) or inactive (greyed out) tasks.
Depending on the event you select, you may need to set up additional parameters:

Configure
If you select Time Period, Mail OnNet displays the Set Time Period dialog box so that you can specify a 
particular time or regular time interval for the task action. If you want to edit the time period specification, 
choose Configure (next to the On Event box) to redisplay the Set Time Period dialog box. Configure is 
unavailable for other events.

Select Folder
If you select Add Mail to Folder, you must select a folder to which messages will be added. (The folder 
must exist prior to setting up the task.) If you select Time Period or User Activated, you must select a 
folder in which to look for messages that satisfy the match criteria. 
Choose Set to display the Select Folder dialog box, where you can select the folder you want from a list of
folders. Select Folder is unavailable for other events.

Current Folder
If you select User Activated, you can select Current Folder in the New Task dialog box to specify that the 
folder which is open when you choose Run Now on the Task Manager dialog box should be searched for 
matching messages. Current Folder is unavailable for other events.

Scan Child Folders
If you select Time Period or User Activated, and you select a folder, you can cause Mail OnNet to search 
for messages in child folders (folders stored within the selected folder) by selecting Scan Child Folders in 
the New Task dialog box. Scan Child Folders is unavailable for other events.

Related Topics
Creating a Task
Editing a Task
Managing Tasks
Selecting the Matching Criteria
When Things Go Wrong with Mail OnNet



Selecting the Matching Criteria

Use the Match Criteria box in the New Task or Edit Task dialog box to determine which messages will be 
acted upon by the task. Mail OnNet searches for messages that contain the matching criteria, then carries
out the actions you select for the task to perform. Select one or more of the following criteria from the 
Select a New Match dialog box:

Selecting Displays
Date The Date Criteria dialog box, where you can specify the date of the message.
Sender The the Sender Contains dialog box, where you can specify which e-mail 

address or name to match in the From: header.
Message Text The Message Text Contains dialog box, where you can specify the string of text 

to match in the message body.
Recipient The Recipient In dialog box, where you can specify the name and e-mail address

to match in the To: and Cc: headers.
Subject The Message Subject Contains dialog box, where you can specify what to match 

in the Subject: header of messages.

To choose one or more matching criteria
1. Choose Add (next to the Match Criteria box) to display the Select a New Match dialog box.
2. Select a match criterion. The criterion appears in the Match Criteria box.
3. Repeat steps 1 and 2 until you are satisfied with the criteria you have selected. Once you select two or

more match criteria, the And Matches and Or Matches options become available.

To delete match criteria
Select a criterion you want to delete from the Match Criteria box, then choose Remove.

To edit match criteria
Select a criterion you want to change (or double-click it), then choose Edit to redisplay the dialog box 
used for setting the criterion.
Note:    There must be at least one match criterion in the box before you can save the task and run it.

Related Topics
Creating a Task
Editing a Task
Managing Tasks
Selecting the Task Action
When Things Go Wrong with Mail OnNet



Selecting the Task Action

Use the Perform Action box of the New Task or Edit Task dialog box to select the actions that will be 
performed by the task. Select one or more of the following actions that you want the task to perform from 
the Select a New Action dialog box:

This action Does this
Forward To Forwards messages that satisfy the matching conditions when a task runs. Select

this action to display the Forward To dialog box.
Select Selects and highlights the messages that satisfy the matching conditions.
Delete Deletes messages that satisfy the matching conditions. Selecting this action 

displays the Confirm Delete dialog box.
Save to Text File Saves to a text file any messages that satisfy the match conditions. Selecting this

action displays the Save to Text File dialog box.
Save to Folder Saves to a folder any messages that satisfy the matching criteria. Selecting this 

action displays the Specify Folder dialog box.
Call Executable Runs an executable program when any messages satisfy the match conditions. 

Select this action to display the Specify Executable dialog box.

To choose one or more actions
1. Choose Add (next to the Perform Action box) to display the Select a New Action dialog box.
2. Select an action. The action appears in the Perform Action box.
3. Repeat steps 1 and 2 until you are satisfied with the actions you have selected.
Note:    If you select multiple actions, they will be performed in the order that you select them.

To delete an action
Select an action you want to delete from the Perform Action box, then choose Remove.

To edit an action
Select an action you want to change (or double-click it), then choose Edit to redisplay the dialog box used
for setting the action.
Note:    There must be at least one action in the box before you can save the task and run it.

Related Topics
Creating a Task
Editing a Task
Managing Tasks
Saving a Task
When Things Go Wrong with Mail OnNet



Saving a Task

Use the Save Task dialog box to save a task that you have just created or edited.

To save a task
1. When you are finished using the New Task dialog box to create a task, or the Edit Task dialog box to 

edit a task, choose OK. The Save Task dialog box appears, displaying your selections for the task in 
the Task Summary box.

2. In the Description box, type a brief description of the task. This description appears next to the task 
filename in the Task Manager dialog box. Type a description that will help you to remember the task 
without looking at the task summary.

3. In the File Name box, type a filename (without the extension) for the task.The name must be no 
greater than eight (8) characters in length.

4. Choose OK to save the task and return to the Task Manager dialog box.
--or--
Choose Cancel to cancel the changes.

Related Topics
Creating a Task
Deleting a Task
Editing a Task
Managing Tasks
What Are Tasks?



Setting the Time Period Event

To set the Time Period event in the New Task or Edit Task dialog box, either select Time Period from the 
On Event box, or choose Configure (next to the On Event box) to display the Set Time Period dialog box.

To run the task at a regular time interval
1. In the In Minutes box, select Every.
2. Type the number of minutes into the Minutes box. You can specify an integer in the range 1 through 

9,999 inclusive.
3. Choose OK.

To run the task at a specific time
1. In the By Time box, select At.
2. In the hour box next to the At option, type an integer in the range 1 through 12 to specify the hour of 

the day.
3. In the minutes box next to the hour box, type an integer in the range 0 through 59 to indicate how 

many minutes past the hour you specified in step 2.
4. Select AM or PM.
5. In the Repeat Every box, select None.
6. Choose OK.

To repeat the task at the same time on a regular basis
1. In the By Time box, select At.
2. In the hour box next to the At option, type an integer in the range 1 through 12 to specify the hour of 

the day.
3. In the minutes box next to the hour box, type an integer in the range 0 through 59 to indicate how 

many minutes past the hour you specified in step 2.
4. Select AM or PM.
5. In the Repeat Every box, select the name of the day of the week you want the task to run.

--or--
To run the task at the same time every day, select Week Day.
--or--
To run the task on a weekend day, select Week End.

6. Choose OK.

Related Topics
Creating a Task
Editing a Task
Managing Tasks
Selecting the Event



Setting a Date as the Task Matching Criterion

Use the Date Criteria dialog box to set up the message date as the criterion for which messages the task 
will act upon.

To match the message date
1. Choose Date in the Match Criteria box of the New Task or Edit Task dialog box to display the Date 

Criteria dialog box.
2. Choose the criterion from the Message Date Is list box:

This date style Sets the match to be...
Equal to Equal to the date that you specify.
Not Equal to Not equal to the date that you specify.
Between Between the two dates that you specify. The And (second) date must be later 

than the Between (first) date.
Not Between Not between the two dates that you specify. The And (second) date must be later 

than the Between (first) date.
After After the date that you specify.
After or Equal to After or equal to the date that you specify.
Before Before the date that you specify.
Before or Equal to Before or equal to the date that you specify.
3. Choose OK.



Setting the Sender as the Task Matching Criterion

Use the Sender Contains dialog box to set up the contents of the From message field as the criterion for 
which messages the task will act upon.

To match the sender
1. Choose Sender in the Match Criteria box of the New Task or Edit Task dialog box to display the 

Sender Contains dialog box.
2. In the Match box, type the name or e-mail address of the message sender, then choose Add. Repeat 

this step for every sender that you want to match; all of your entries appear in the Match box. If you 
specify more than one sender, the match is made if any of the senders are matched.
If you want the match to be case sensitive, select the Case Sensitive option.
Note:    To make the match as accurate as possible, type the most complete text of each name or 
address that you want to match. For example, if you want to match a senders name, type the full name
of the sender, not just the first or last name. 

3. Choose OK.

To remove a sender from the Match box
If you are editing an existing task, select an entry in the Match box and choose Delete to remove it from 
the Match box.



Setting the Message Text as the Task Matching Criterion

Use the Message Text Contains dialog box to set up the contents of the message body as the criterion for
which messages the task will act upon.

To match the message text
1. Choose Message Text in the Match Criteria box of the New Task or Edit Task dialog box to display the 

Message Text Contains dialog box.
2. In the Match box, type the message text that you want to match, then choose Add. Repeat this step 

until all text entries that you want to match are listed in the Match box. If you want the match to be 
case sensitive, select the Case Sensitive option.
Note:    To make the match as accurate as possible, type the most complete text that you want to 
match. For example, if you want to match the phrase second mortgage, type the entire phrase, not just
second or only mortgage. 

3. Under Must Match, select the Any One of These Entries option if you want messages that contain any 
of the text entries to be acted upon by the task. For example, if you enter the phrases auto loan and 
home improvement loan into the Match box, then select Any One of These Entries, any message that 
contains either phrase is matched.
--or--
Select the All of These Entries option if you only want messages that contain all of the text entries to 
be acted upon by the task. For example, if you enter the phrases home mortgage and financial 
services into the Match box, then select All of These Entries, only messages that contain both phrases
are matched.

4. Choose OK.

To remove an entry from the Match box
If you are editing an existing task, select an entry in the Match box and choose Delete to remove it from 
the Match box.



Setting Recipients as the Task Matching Criterion

Use the Recipient In dialog box to set up the recipient in the To: or Cc: message headers as the match for
the task.

To match the recipient
1. Choose Recipient in the Match Criteria box of the New Task or Edit Task dialog box to display the 

Recipient In dialog box.
2. In the Either To or Cc box, type the name or e-mail address of the message recipient. This box 

specifies that the match can be made in either field. 
--or--
In the Only in Specified Header boxes, type the name or e-mail address of the message recipient in 
the To: box, the Cc: box, or both boxes. If you type text in both the To: and Cc: headers, a message 
must be matched in both headers for it to be chosen. 
Note:    The name or address you enter will be matched if it appears anywhere in the text of the 
relevant field. For example, entering jo will match messages sent to john, joy, and david jones 
as well as jo. To make the match as accurate as possible, make your text as complete and specific as
possible.
You cannot match more than one recipient at a time. If you type john, chris, lee into any of the 
text boxes, the match will only occur on messages that contain the phrase john, chris, lee, not 
on the individual names.

3. If you want matches to be made only if the case of the text in the message fields exactly matches the 
case of the text in the items you have added, select Match Case. (The same case sensitive setting 
applies to all of the items that you specify; you cannot set it separately for each one.

4. Choose OK.



Setting the Message Subject as the Task Matching Criterion

Use the Message Subject Contains dialog box to set up the Subject: header of the message as the text to
match in messages.

To match the message subject
1. Choose Message Subject in the Match Criteria box of the New Task or Edit Task dialog box to display 

the Message Subject Contains dialog box.
2. In the Match box, type the message subject you want to match, then choose Add. Repeat this step 

until all subject entries that you want to match are listed in the Match box. If you enter more than one 
subject in the Match box, the match will occur if the message contains any of the subjects listed.
If you want the match to be case sensitive, select the Case Sensitive option.
Note:    To make the match as accurate as possible, type the most complete text that you want to 
match. For example, if you want to match the subject Second report is due, type the entire phrase, not 
just Second or only due. 

3. Under Must Match, select Any One of These Entries if you want messages that contain any of the 
subject entries to be acted upon by the task. For example, if you enter the phrases auto loan and 
home improvement loan into the Match box, then select Any One of These Entries, any message that 
contains either phrase in its Subject field is matched.
--or--
Select the All of These Entries option if you only want messages that contain all of the subject entries 
to be acted upon by the task. For example, if you enter the phrases home mortgage and financial 
services into the Match box, then select All of These Entries, only messages that contain both phrases
in their Subject: headers are matched.

4. Choose OK.

To remove a subject from the Match box
If you are editing an existing task, select an entry in the Match box and choose Delete to remove it from 

the Match box.



Setting Delete as the Task Action

Use the Confirm Delete dialog box to set up the confirming of any removed messages when a task runs.

To set the Delete action
1. In the New Task dialog box, choose Add (next to the Perform Action box) to display the Select a New 

Action dialog box. Choose Delete from the displayed list, then choose OK.
--or--
In the Edit Task dialog box, select Delete from the Perform Action box, then choose Edit (next to the 
Perform Action box).

2. Select Confirm deletion in the Confirm Delete dialog box if you want Mail OnNet to prompt you for 
confirmation before the task deletes the messages as it runs.

3. When you are finished, choose OK.



Setting Save to Text File as the Task Action

Use the Save to Text File dialog box to set up the saving of messages to text files when a task runs.

To set the Save to Text File action
1. In the New Task dialog box, choose Add (next to the Perform Action box) to display the Select a New 

Action dialog box. Choose Save to Text File from the displayed list, then choose OK.
--or--
In the Edit Task dialog box, select Save to Text File from the Perform Action box, then choose Edit 
(next to the Perform Action box).

2. In the File Name box of the Save to Text File dialog box, type the full path and file name of the text file 
to which you want to save the messages. If the pathname and filename that you specify do not yet 
exist, they will be created.
--or--
Choose Browse to display the Windows Save As dialog box, where you can choose the file from your 
directories.

3. Select Append to Existing File if you want the new messages added to an existing file with the given 
filename.
--or--
Do not select it if you want to overwrite the file you specified with the contents of the saved message 
each time the task runs.

4. When you are finished, choose OK.



Setting Save to Folder as the Task Action

Use the Specify Folder dialog box to set up the moving or copying of messages to a folder when a task 
runs.
Note:    The folder must be created before you create the task to move messages to the folder.

To set the Save to Folder action
1. In the New Task dialog box, choose Add (next to the Perform Action box) to display the Select a New 

Action dialog box. Choose Save to Folder from the displayed list, then choose OK.
--or--
In the Edit Task dialog box, select Save to Folder from the Perform Action box, then choose Edit (next 
to the Perform Action box).

2. Choose Folder Name in the Specify Folder dialog box. The Select Folder dialog box appears.
3. Select the folder you want to copy messages to, then choose OK to return to the Specify Folder dialog 

box. The name of the folder you selected appears below Folder Name.
Note:    You cannot save messages to either the In-Tray or Out-Tray folders, even though they may be 
displayed in the list of folders.

4. Move Messages to Folder is the default. If you want to copy the messages instead of moving them, 
deselect Move Messages to Folder.

5. When you are finished, choose OK. The name of the folder you selected appears in the New Task or 
Edit Task dialog box.



Setting Call Executable as the Task Action

Use the Specify Executable dialog box to set up the calling of an executable program when a task runs.

To set the Call Executable action
1. In the New Task dialog box, choose Add (next to the Perform Action box) to display the Select a New 

Action dialog box. Choose Call Executable from the displayed list, then choose OK.
--or--
In the Edit Task dialog box, select Call Executable from the Perform Action box, then choose Edit (next
to the Perform Action box).

2. In the File Name box of the Specify Executable dialog box, type the full path and file name of the .EXE
file.
--or--
Choose Browse to display the Windows Specify Filename dialog box, where you can choose the file 
from your directories.

3. In the Parameters box, type the parameters you want to pass to the program when it is run.
4. Select Calls for Every Matching Message if you want the program to run for every message selected 

by the task.
--or--
Do not select it if you want the program to run only once, no matter how many messages are matched,
provided that one message is selected by the task.

5. When you are finished, choose OK.



Setting Forward To as the Task Action

Use the Forward To dialog box to set up the forwarding of messages when a task runs.

To set the Forward To action
1. In the New Task dialog box, choose Add (next to the Perform Action box) to display the Select a New 

Action dialog box. Choose Forward To from the displayed list, then choose OK.
--or--
In the Edit Task dialog box, select Forward To from the Perform Action box, then choose Edit (next to 
the Perform Action box).

2. In the To box of the Forward To dialog box, type the names or e-mail addresses of the recipients you 
want the messages forwarded to, separating them with semicolons. In the Cc box, type the names or 
e-mail addresses of those recipients that you want to send copies to, separating them with 
semicolons. 
--or--
Choose Address to display the Address Book dialog box, where you can choose names and 
addresses.

3. You can include text with the forwarded message. Select one of the following options:
None.(Default) This option includes no text with the forwarded message.This is the default.
From File    This option lets you append a text file to the message. You can specify the full path and 
filename of the text file, or you can choose Browse, which displays the Select File to Append dialog 
box. Use the Select File to Append box to browse through your directories for the file.
Specified Text This option lets you specify the text to be appended to the message. Choose Edit 
to display the Edit Text Which Is Appended dialog box. Type your text into the box, then choose OK.

4. To set the priority of the forwarded message, select a priority from the Priority options:
As Original. Sets the priority to that of the original message for the forwarded message.
Urgent/Normal/Low. Sets the priority to a high, typical, or low priority, depending on which of these 
that you select.

5. When you are finished, choose OK.



Managing Tasks

To manage your tasks, choose Tasks from the Tools menu to display the Task Manager dialog box. 
The Tasks box lists all of the tasks that you have created. The tasks are identified by the filename used to 
save them and a brief description you provided when you saved the task. Tasks are grayed when they are
not active.
When a task runs, a task log is created to monitor its activity.

To run a user activated task
1. Select the task in the Tasks box.
2. Choose the Run Now button. 
3. Choose Done to close the Task Management dialog box and return to the main window.
Note:    The task will be run even if the task is inactive.

To activate or deactivate a task
You do not have to delete a task to prevent it from running; instead, you can deactivate the task.
1. Select the task in the Tasks box.
2. Choose Deactivate if the task is active.

--or--
Choose Activate if the task is inactive (greyed out).

3. Choose Done to close the Task Management dialog box and return to the main window.

To run a task log
Select the task you want to log in the Tasks box, then choose Task Log. A log will accumulate for the task 
activity each time it runs.

To view a task log
1. Select the task whose log you want to view from the Tasks box, then choose Task Log. The log 

contents are displayed in the Task Log dialog box.
2. When you are finished reviewing the task log, choose Done.

--or--
Choose Clear to erase the task log contents.

Choose this button To do this
New Display the New Task dialog box to create a task.
Edit Display the Edit Task dialog box to edit an existing task.
Delete Delete a selected task. Use the New Task dialog box to recreate a deleted task.
Done Return to the Mail OnNet main window.

Related Topics
Creating a Task
Deleting a Task
Editing a Task
Saving a Task
What Are Tasks?
When Things Go Wrong with Mail OnNet



Selecting a Folder for Tasks

If you choose the Add Mail to Folder, Time Period, or User Activated event, you must select a folder (or 
group of folders). For the Add Mail to Folder option, the event is run only if a message is added to the 
selected folder. For the Time Period or User Activated options, the task is only applied to messages in the 
selected folder(s) that satisfy the match conditions.

To select a folder
1. In the New Task dialog box, choose Set (below the Folder: prompt) to display the Select Folder dialog 

box.
--or--
For User Activated events, select Current Folder (below the Folder: prompt) if you want Mail OnNet to 
search for messages satisfying the match conditions in the current folder (the folder that is selected 
when you run the task).
--or--
For Time Period and User Activated events, select Scan Child Folders (below the Folder: prompt) if 
you want Mail OnNet to search for messages in any folders within the selected folder.

2. Select a folder from the list box.
3. Choose OK. The folder you selected appears next to the Folder: prompt on the New Task or Edit Task 

dialog box.



Editing a Task

Use the Edit Task dialog box to edit a task you have already created.

To edit a task
1 Select the task you want to edit in the Tasks box of the Task Manager dialog box.
2 Choose Edit to display the Edit Task dialog box. Change one or more of the following parts of the task 

as necessary:
events to trigger the task
matching criteria for the task
actions to be performed by the task

3. To close the Edit Task dialog box and save the task, choose OK to display the Save Task dialog box.
4. After you have saved the task, choose Done to close the Task Management dialog box and return to 

the main window.
You can choose Show Summary in the Edit Task dialog box to display a descriptive summary of the task. 
To hide the task summary when it is displayed, choose Hide Summary.

Related Topics
Creating a Task
Deleting a Task
Managing a Task
Saving a Task
What Are Tasks?



Deleting a Task

You can only delete a task from the Task Manager dialog box. Once you delete a task, you can only 
recreate it by using the New Task dialog box.

To delete a task
1 Select the task you want to delete in the Tasks box.
2 Choose Delete.
3. Choose Done to close the Task Management dialog box and return to the main window.

Related Topics
Creating a Task
Editing a Task
Managing Tasks
Saving a Task
What Are Tasks?



What Are Tasks?

Tasks let you automate a range of actions while processing your messages in Mail OnNet. They make it 
easier to carry out actions that you need to repeat frequently, or actions that you may only want to carry 
out once, but which involve many messages. 
The Task dialog boxes help you to define your own tasks with the following components:
· Events:    When a task should be carried out, such as when new mail is received, when messages are 

sent, or at a particular time each day.
· Match Criteria:    Which messages the task should be applied to, such as those in a particular folder, 

those earlier than a particular date, those received from or sent to certain people, or those about 
certain subjects or containing particular keywords.

· Actions:    What should be done to the messages; for example, they can be selected, moved between 
folders or deleted. You can even use tasks to launch your own programs.

Related Topics
Creating a Task
Deleting a Task
Editing a Task
Managing Tasks
Saving a Task
When Things Go Wrong with Mail OnNet



And Matches and Or Matches
These selections become available after you have selected two or more match criteria in the Match 
Criteria list box.

Select this To specify 
And Matches Only those messages matching ALL of the conditions you have set.
Or Matches All messages matching ANY of the conditions you have set.



    Active Tasks
Tasks can be either active or inactive. An active task is run when the event defined for it occurs; 
inactive tasks are not run even if the event occurs. When a task is inactive its light bulb in the Tasks list
in the Task Managementtasks dialog box is unlit and the task appears grayed. If you select an inactive 
task, the Deactivate button changes to Activate.



Correcting the Spelling of Your Messages

You can verify or correct the spelling of the text of your mail messages before you send them. The 
spelling tool does not examine the spelling of attachments or of message headers. 

To correct the spelling of your message text
1. With the cursor in the body of the message displayed in the Compose window, choose Spelling from 

the Tools menu.

--or--
Choose the Correct Spelling button on the toolbar.

If your message contains any misspelled words, the Word Not Found in Dictionary dialog box appears,
with the first misspelled word shown in the Not Found text box. 

Note:    If the spelling tool finds no misspellings, the Word Not Found in Dictionary dialog box does not 
appear. You can proceed to send your message.

2. To display a list of possible replacement words, choose the Suggestions button to the left of the Not 
Found text box.

A list appears in the Suggestions list box, with the first replacement word also shown in the Replace 
With text box. Proceed to step 3.

--or--
The message No Suggestions is displayed in the Suggestions list box. Proceed to 
step 4.

3. If you want to accept the suggested replacement word, choose Replace. This instance of the 
misspelled word is replaced.

--or--
If you want the suggested replacement to correct every instance of the misspelled word, choose 
Replace All.

--or--
If you want to be prompted before the suggested replacement in the Replace With box is used to 
correct each instance of the misspelled word, choose Prompt Replace.

Note:    You can substitute another suggested replacement by selecting it from the list. You can then 
choose the Suggestions button to the left of the Replace With text box to display another list that is 
based on this new word.

4. If the message No Suggestions appears in the Suggestions list box, type a replacement word into 
the Replace With text box, then choose Replace, Replace All, or Prompt Replace.

5. If you want to add the word that appears in the Not Found text box to your customized dictionary, 
choose Add to Custom.

Note:    If you have more than one customized dictionary file loaded, select which dictionary that you 
want to add the suggested replacement to from the customized dictionary list box that appears just 
below Add to Custom, then choose Add to Custom.

The spelling tool repeats this procedure until it finds no more misspelled words, or until you close the 
dialog box. Before you close the Word Not Found in Dictionary dialog box, you can also choose Options 
to set options that affect the search capabilities and capacity of the spelling tool.

Related Topics
Adding or Unloading a Customized Dictionary



Adjusting the Speed and Efficiency of the Dictionary Searches
Changing the Suggested Replacements Limit
Setting the Spelling Tool Options



Setting the Spelling Tool Options

To display the Spell Options dialog box, choose Options from the Word Not Found in Dictionary dialog 
box.

Select this option To have the spelling tool do this
Automatic Suggestions Automatically generate and display a list of possible replacement words for the 

misspelled word in the Word Not Found in Dictionary dialog box.

Exact Match Required Match exactly the misspelled word candidate as the spelling tool inserts 
replacement words into the message text. This option is useful when, for 
example, you want to replace wood with would, but not woodworking with 
wouldworking.

Ignore Full Caps Ignore words that appear in all capital letters. Words with initial capital letters are 
not ignored. For example, the acronym TEH would be ignored, but the word Teh 
would be considered a misspelled word.

Ignore Partial Numbers Ignore words that contain numbers as well as letters. For example, your message
might mention a filename, car54, that contains numbers as well as letters.

Ignore Pure Numbers Ignore numbers.

Allow Joined Words Ignore two words that are joined together, and that also appear as one word in 
either dictionary used. Joined words that do not appear in either the customized 
or the standard dictionaries are considered to be misspelled words.

Recheck Typed Replaces

Verify the spelling of any replacement words that you type into the Replace With 
text box that appears in the Word Not Found in Dictionary dialog box.

To turn off an option, clear the option's checkbox. To put the selected option into effect, choose OK when 
you are ready to return to the Word Not Found in Dictionary dialog box.

Related Topics
Adding or Unloading a Customized Dictionary
Adjusting the Speed and Efficiency of the Dictionary Searches
Changing the Suggested Replacements Limit
Correcting the Spelling of Your Message Text



Adding or Unloading a Customized Dictionary

The spelling tool relies on two dictionaries for its verification and correction of words found in your 
message text: a standard American English dictionary, and a customized dictionary that you can add 
words to while using the spelling tool. You can add another customized dictionary to use in addition to or 
instead of the default customized dictionary (CUSTFTP.DIC), but do not substitute a different standard 
dictionary. 

If you want to add or substitute a different customized dictionary, the customized dictionary file must 
comply with the following format:

· The filename must have the .DIC filename extension.
· The file must be an ASCII text file.
· Each word in the file must occupy its own line in the file, followed by a carriage return character.

In addition, make certain that you have a text editor on your system that you can use to edit the file. You 
can add words to the customized dictionary file while using the tool, but you cannot also remove them 
while using it; however, you can remove any entry from the file by using a text editor.

To add another customized dictionary
1. From the Word Not Found in Dictionary dialog box, choose Options.

2. In the Spell Options dialog box, choose Open Custom. The Open Custom Dictionary dialog appears.

3. Browse for the customized dictionary file that you want to use (it has the filename extension .DIC), 
select it with the mouse pointer, then choose OK.

4. In the Spell Options dialog box, the selected dictionary appears in the customized dictionary list box 
that is just below the Open Custom button. When you are ready, choose OK to return to the Word Not 
Found in Dictionary dialog box.

To unload a customized dictionary
1. From the Word Not Found in Dictionary dialog box, choose Options.

2. In the Spell Options dialog box, select the dictionary that you want to unload from the customized 
dictionary list box that is just below the Open Custom button, then choose Unload Custom. The 
selected dictionary disappears from the customized dictionary list.

3. When you are ready, choose OK to return to the Word Not Found in Dictionary dialog box.

Related Topics
Adjusting the Speed and Efficiency of the Dictionary Searches
Changing the Suggested Replacements Limit
Correcting the Spelling of Your Message Text
Setting the Spelling Tool Options



Adjusting the Speed and Efficiency of the Dictionary Searches

For every word that the spelling tool encounters in your message, the tool searches the standard 
dictionary, and then your customized dictionary, until a match can be found for the word. If no match can 
be found, the spelling tool generates a list of suggested replacements for the misspelled word. 

You can adjust the speed of the dictionary searches, but be aware that the faster the search, the more 
system memory that is required for the search.

To adjust the speed of the dictionary searches
1. From the Word Not Found in Dictionary dialog box, choose Options.

2. In the Spell Options dialog box, slide the Performance/Memory Usage slider control to increase or 
decrease the search speed. As you increase the search speed, memory use increases accordingly.

3. When you have finished adjusting the control, choose OK.

Note:    Your adjustment will remain in effect only until you exit from Mail OnNet. The setting returns to its 
default (the mid-way point) after you exit from the application.

Related Topics
Adding or Unloading a Customized Dictionary
Changing the Suggested Replacements Limit
Correcting the Spelling of Your Message Text
Setting the Spelling Tool Options



Changing the Suggested Replacements Limit

You can change the number of suggested replacements that the spelling tool produces for each 
misspelled word that it encounters in your message text.

To change the suggested replacements limit
1. From the Word Not Found in Dictionary dialog box, choose Options.

2. In the Spell Options dialog box, type the new limit in the Suggestion Search Limit text box. The 
maximum is 65,535 suggestions.

3. When you are satisfied with the new limit, choose OK.

Related Topics
Adding or Unloading a Customized Dictionary
Adjusting the Speed and Efficiency of the Dictionary Searches
Correcting the Spelling of Your Message Text
Setting the Spelling Tool Options



Logging On to Mail OnNet

When you start Mail OnNet, the Mail Logon dialog box appears. You can log on to Mail OnNet, or create a
new username and password.
Note:    You use the Mail Logon username and password pair to log on to Mail OnNet at your PC. You use
a separate username and password for authentication on your mail server.

To log on to Mail OnNet
1. In the User name box, type your username to identify yourself to Mail OnNet, then move the cursor to 

the Password box.
2. In the Password box, type your password. Note that the password appears as a row of asterisks (*) to 

prevent others from learning your password as it displays on the screen.
3. Choose OK.

To create a new Mail OnNet user (or log on for the first time)
1. In the Mail Logon dialog box, select Create New User, then choose OK. Mail OnNet prompts you to 

enter your username and password pair. 
2. In the User name box, type your username, then move the cursor to the Password box.
3. In the Password box, type your password. Note that the password appears as a row of asterisks (*) to 

prevent others from learning the password as it displays on the screen.
4. Choose OK. You will then proceed to configure Mail OnNet for the new user or yourself by supplying 

needed information on several dialog boxes.
Note:    After you configure Mail OnNet for your use, you can skip the Mail Logon dialog box during future 
starts of Mail OnNet if you select Skip Logon from the Settings menu. The Skip Logon option is available 
to you only if you are the sole user of Mail OnNet on your PC.

Related Topics
Providing Basic User Information
Requirements for Mail OnNet Configuration



Requirements for Mail OnNet Configuration

Mail OnNet requires information about your mail environment so that you can send and receive mail. 
Before you continue with your Mail OnNet configuration, make certain that you have ready the following 
information about the network to which you are connected:
· The full network domain name (for example, mailserv.xyz.com) or IP address (for example, 

128.127.50.100) of the network mail servers assigned to sending and receiving your mail. Your 
system administrator or Internet service provider may assign a different mail server to perform each 
task, but it is not uncommon for one server to perform both the sending and the receiving of mail.

· The network mail protocol software used by the mail servers to send and receive mail. Mail OnNet 
works with servers that run the Simple Mail Transfer Protocol (SMTP) to send messages, and either 
Post Office Protocol 2 (POP2) or 3 (POP3) to receive messages.

· The full network domain name or IP address assigned to your PC by your system administrator or 
Internet service provider.

· The login username and password assigned to you for connecting to the server that receives your 
mail, from which Mail OnNet retrieves your messages. This is the server that runs either POP2 or 
POP3 to receive your mail. 
Note: This login name and password are separate from the pair you use to start Mail OnNet at your 
PC.

· The electronic mail (e-mail) address assigned to you by your system administrator or Internet service 
provider. For example, your address might be jdoe@xyz.com or beverly@example.org.

Note: Contact your system administrator or Internet service provider for this information.
If you are ready to proceed, choose Continue from the Mail Settings dialog box. Otherwise, choose 
Cancel to exit from Mail OnNet.

Related Topics
Changing Your Password
Configuring the Retrieving of POP2 Messages
Configuring the Retrieving of POP3 Messages
Configuring the Sending of Messages
Logging on to Mail OnNet
Providing Basic User Information
Specifying Locations for the Address Book and Message Store



Providing Basic User Information

The User Information dialog box lets you specify basic mail environment information and the network 
protocols used by the mail servers that send and receive your mail.

To provide user information
1. To display the User Information dialog box, choose Mail Configuration from the Settings menu, enter 

your username and password in the Mail Logon dialog box, then choose OK.
2. In the Full Name box, type your full name as you would like it to appear in the From: header of your 

messages. For example, type John Doe or Jane Smith.
3. In the E-mail Address box, type the electronic mail (e-mail) address assigned to you by your system 

administrator or Internet service provider, such as jdoe@xyz.com.
4. In the PC Name box, type the full network hostname and    domain name, such as 

pc_name.xyz.com, or the IP address, such as 128.127.50.100, that your system administrator or 
Internet service provider assigned to your PC.

5. In the Start Mail In: set of options, select either Online Mode or Offline Mode. The default is Online 
Mode.

6. In the Retrieve Mail Using box, select the network mail protocol, POP2 or POP3, used by the mail 
server to deliver mail to Mail OnNet.

7. In the Send Mail Using box, select the protocol used by the mail server that sends your messages: 
SMTP.

8. If you are ready to proceed to the next step, choose OK.
--or--

Choose this button To do this
Cancel Cancel this procedure.
Locations Display the Locations dialog box, where you can modify the full pathnames for 

both the address book and the message store. Use this option if you already 
have message store folders and an address book that you want to use.

Password Display the Change Password dialog box, where you can specify a new 
password for logging on to Mail OnNet at your PC.

Trace Display the Network Tracing Setup dialog box, where you can turn on logging of 
Mail OnNet network connectivity information and display it on your screen or 
save the information to a file.

Related Topics
Changing Your Password
Configuring the Retrieving of POP2 Messages
Configuring the Retrieving of POP3 Messages
Configuring the Sending of Messages
Logging on to Mail OnNet
Specifying Locations for the Address Book and Message Store



Configuring the Retrieval of POP2 Messages

Use the Retrieve Mail Settings dialog box to specify information about the mail server from which Mail 
OnNet retrieves your messages.

To specify POP2 mail retrieval settings
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. After selecting POP2 as your mail retrieval protocol in the User 
Information dialog box, choose OK to display the POP2 Retrieve Mail Settings dialog box.

2. In the POP2 Server box, type the network hostname and domain name or the IP address of the POP2 
server. An example name is mailserv.xyz.com and an example IP address is 128.127.50.100.

3. In the Login Name box, type the username that your system administrator or Internet service provider 
assigned to you for the POP2 server. For example, your user name might be jdoe.
Note:    Mail OnNet uses this username and password logon pair for authentication when it retrieves 
your messages from the POP2 server. You use a separate username and password to log on to Mail 
OnNet at your PC.

4. In the Password box, type the password that your system administrator or Internet service provider 
assigned to you for the POP2 mail server. Your password appears in the box as a string of asterisks 
(*)to prevent others from learning your password as it displays on the screen.
Note:    If your Internet service provider or system administrator changes your password for the POP2 
mail server, you must change the password setting in the Retrieve Mail Settings dialog box to match 
the new password. Otherwise, Mail OnNet will be unable to retrieve your messages.

5. In the Check For New Mail Every N Minutes box, enter a number representing the minutes that must 
elapse before Mail OnNet automatically retrieves messages that are waiting for you on the POP2 
server. The default is 10 minutes. Setting this value to zero (0) disables automatic retrieval of mail. You
can check for new mail manually at any time by choosing Check Mail from the File menu or the 
toolbar.

6. Under the After Getting Mail field, select one of the following options:
Delete Copy of Mail on Server. If you select this option (the default), Mail OnNet retrieves 
your mail from the POP2 server and puts it into your In-Tray folder. After the messages are retrieved 
successfully, the copies of your messages on the mail server are deleted. With this option, only unread
messages are downloaded to your PC from the server.
Leave a Copy of Mail on Server. If you select this option, Mail OnNet retrieves both read and 
unread messages from the POP2 server, and copies of them remain on the server. Each time that Mail
OnNet checks for new mail, it retrieves all of your messages, regardless of whether or not you have 
already retrieved them. You may want to set this option if you plan to check your mail from another 
location while you are away from your PC.

7. Select Update Address Book with New Addresses on Retrieval if you want Mail OnNet to update your 
address book automatically with any electronic mail (e-mail) addresses it finds in the To: or Cc: 
headers of your incoming messages. If you do not select this option, the address book is updated only 
when you approve the entering of addresses into it yourself.

8. Choose MIME to display the MIME Retrieve Setup dialog box, where you can specify MIME settings 
other than the defaults. 
--or--
If you want to accept the MIME defaults, which are appropriate for most systems, do not choose 
MIME.

9. When you are satisfied with the information you have provided, choose OK.
--or--
Choose Cancel to end this procedure without making any changes.

Related Topics
Configuring the Retrieving of POP3 Messages
Configuring the Sending of Messages
Logging on to Mail OnNet
Providing Basic User Information



Setting Up MIME Conversions of Retrieved Messages



Configuring the Retrieval of POP3 Messages

Use the Retrieve Mail Settings dialog box to specify information about the mail server from which Mail 
OnNet retrieves your messages.

To specify POP3 mail retrieval settings
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. After selecting POP3 as your mail retrieval protocol in the User 
Information dialog box, choose OK to display the POP3 Retrieve Mail Settings dialog box.

2. In the POP3 Server box, type the network hostname and domain name or the IP address of the POP3 
server. An example name is mailserv.xyz.com and an example IP address is 128.127.50.100.

3. In the Login Name box, type the username that your system administrator or Internet service provider 
assigned to you for the POP3 server. For example, your user name might be jdoe.
Note:    Mail OnNet uses this username and password logon pair for authentication when it retrieves 
your messages from the POP3 server. You use a separate username and password to log on to Mail 
OnNet at your PC.

4. In the Password box, type the password that your system administrator or Internet service provider 
assigned to you for the POP3 mail server. Your password appears in the box as a string of asterisks 
(*)to prevent others from learning your password as it displays on the screen.
Note:    If your Internet service provider or system administrator changes your password for the POP3 
mail server, you must change the password setting in the Retrieve Mail Settings dialog box to match 
the new password. Otherwise, Mail OnNet will be unable to retrieve your messages.

5. In the Check For New Mail Every N Minutes box, enter a number representing the minutes that must 
elapse before Mail OnNet automatically retrieves messages that are waiting for you on the POP3 
server. The default is 10 minutes. Setting this value to zero (0) disables automatic retrieval of mail.
Note: At any time, you can manually check for new mail by choosing Check Mail from the File menu or
the toolbar.

6. Under the After Getting Mail field, select one of the following options:
Delete Copy of Mail on Server. If you select this option (the default), Mail OnNet retrieves 
your mail from the POP3 server and puts it into your In-Tray folder. After the messages are retrieved 
successfully, the copies of your messages on the mail server are deleted. With this option, only unread
messages are downloaded to your PC from the server.
Leave a Copy of Mail on Server. If you select this option, Mail OnNet retrieves both read and 
unread messages from the POP3 server, and copies of them remain on the server. Each time that Mail
OnNet checks for new mail, it retrieves all of your messages, regardless of whether or not you have 
already retrieved them. You may want to set this option if you plan to check your mail from another 
location while you are away from your PC.

7. Select Update Address Book with New Addresses on Retrieval if you want Mail OnNet to update your 
address book automatically with any electronic mail (e-mail) addresses it finds in the To: or Cc: fields 
of your incoming messages. If you do not select this option, the address book is updated only when 
you approve the entering of addresses into it yourself.

8. Choose MIME to display the MIME Retrieve Setup dialog box, where you can specify MIME settings 
other than the defaults. 
--or--
If you want to accept the MIME defaults, which are appropriate for most systems, do not choose 
MIME.

9. When you are satisfied with the information you have provided, choose OK.
--or--
Choose Cancel to end this procedure without making any changes.

Related Topics
Configuring the Retrieving of POP2 Messages
Configuring the Sending of Messages
Logging on to Mail OnNet
Providing Basic User Information



Setting Up MIME Conversions of Retrieved Messages



Configuring the Sending of Messages

Use the Send Mail Settings dialog box to specify how Mail OnNet sends messages from your PC to the 
mail server that sends your mail over the network. This server uses the Simple Mail Transfer Protocol 
(SMTP) to send your mail.

To specify settings for sending mail
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. After entering information in the User Information and POP2 or 
POP3 Retrieve Mail settings dialog box, choose OK to display the Send Mail Settings dialog box.

2. In the SMTP Server box, type the network hostname and domain name or the IP address of the mail 
server that sends your messages over the network. An example name is mailserv.xyz.com and an
example IP address is 128.127.50.100.
Note: This server may not be the same server as the one from which Mail OnNet retrieves your mail.

3. Select the Issue Warnings for Messages Over N Kbytes box if you want to be warned when you try to 
send a message larger than the figure you enter in the Kbytes box. 
If you attempt to send a large message, you will be warned and given the opportunity to cancel 
sending the message.

4 Choose MIME to display the MIME Send Setup dialog box, where you can specify MIME settings other
than the defaults.
--or--
If you want to accept the MIME defaults, which are appropriate for most systems, do not choose 
MIME.

5. When you are satisfied with the information you have provided, choose OK.
--or--
Choose Cancel to end this procedure without making any changes.

Related Topics
Logging on to Mail OnNet
Providing Basic User Information
Setting Up MIME Conversions of Sent Messages



Setting Up MIME Conversions of Sent Messages

The Mail OnNet MIME Send Setup dialog box lets you change the default settings for the conversion of 
sent messages from MAPI to MIME format.
When you send a message, it has to be converted from the MAPI format to the MIME format. Mail OnNet 
has default settings in its default conversion files, but if you are an experienced electronic mail (e-mail) 
user, you can use your own conversion configuration files. 
Mail OnNet allows you to define two separate configuration files: a User configuration file and a System 
configuration file. When you send a message, Mail OnNet searches your User configuration file first, then 
your System configuration file, and finally the Mail OnNet defaults, until it finds a conversion for the type of
message being sent.
Note:    You can specify either separate conversion configuration files for retrieving, sending, and storing 
messages in the message store, or one conversion file for all of these activities. The MIME and MAPI 
Conversion Files help topic describes the format used in conversion files.

To set different MAPI to MIME conversions
1. Choose MIME in the Send Mail Settings dialog box to display the Mail OnNet MIME Send Setup dialog

box.
2. Under Enter MIME conversion configuration files, type the full path and filenames of your conversion 

files in the System File and User File boxes.
--or--
If you decide to use the Mail OnNet default conversion files instead, do not type anything into these 
boxes.

3. Select the secondary character set (or enter the name of a character set) that you want to use in the 
MIME message for any text that is not US-ASCII. Mail OnNet recognizes US-ASCII and ISO-8859-1 to
ISO-8859-9, which are the character sets recommended in the MIME Request For Comment 
document (RFC 1521).

4. Select the 7-bit encoding, or enter the name of your own 7-bit encoding, that you want to use for US-
ASCII text in the message. The accepted encodings are:

7bit
8bit
quoted-printable
base64
binary
Any 7-bit encoding you define within the conversion configuration file.

The default is 7bit for 7-bit encoding.
5. Select the 8-bit encoding, or type the name of your own 8-bit encoding, that you want to use in the 

MIME message for text other than US-ASCII. The accepted encodings are:
7bit
8bit
quoted-printable
base64
binary
Any encoding that you have defined within the conversion configuration file.

The default is quoted-printable for 8-bit encoding.
6. MIME mail systems can cope with messages containing lines longer than 76 characters, but if you are 

sending mail to sites that do not have a MIME-capable mail system, you must set a restriction on the 
length of message text lines so that the message can be read. This ensures that the quoted-printable 
encoding will be used for long lines.
To set the limit, select the Encode long lines with more than n characters box, then enter the upper 
limit on line length in the characters box. 
Accepted values are in the range 76 to 1024. The default setting is a line length of 76 characters.

7. Under Do Not Show Warnings For, select any warning you do not want to receive if Mail OnNet has a 
problem converting your message from MAPI to MIME format.

8. When you are ready, choose OK.



--or--
Choose Cancel to make no changes and accept the defaults.

Related Topics
Configuring the Sending of Messages



Setting Up MIME Conversions of Retrieved Messages

The MIME Retrieve Setup dialog box lets you change the default settings for the conversion from MIME to
MAPI format of messages retrieved by Mail OnNet from your mail server.
When Mail OnNet retrieves a message, it must be converted from MIME to MAPI format. Mail OnNet has 
default settings in its conversion files, but if you are an experienced electronic mail (e-mail) user, you can 
use your own conversion configuration files. 
Mail OnNet allows you to define two separate configuration files: a System configuration file and a User 
configuration file. When you send a message, Mail OnNet searches your User configuration file first, then 
your System configuration file, and finally the Mail OnNet defaults, until it finds a conversion setting for the
type of message being sent.
Note:    You can specify either separate conversion configuration files for retrieving, sending, and storing 
messages in the message store, or one conversion file for all of these activities. The MIME and MAPI 
Conversion Files help topic describes the format used in conversion files.

To set different MIME to MAPI conversions
1. Choose MIME in the Retrieve Mail Settings dialog box to display the MIME Retrieve Setup dialog box.
2. Type the full pathnames and filenames of your conversion files in the System File and User File boxes.

--or--
If you want to accept the Mail OnNet default conversion files, do not type anything in the boxes.

3. MIME messages can hold alternative forms of the same data in a message so that the receiving 
system can choose the format that suits it best. When you receive such a message, Mail OnNet has to
select which version to use. Under Choose MIME types, select one of the following options:
Configuration File Order. The order defined in the conversion configuration file. Order refers 
to the order in which conversions occur in the file; the earlier they occur in the file, the higher their 
priority.
E-Mail Message Order. The order of parts in the message itself as the basis for deciding which 
part to use. The recommended order of parts in a MIME message goes from simplest (for example, 
plain text) to most complex (for example, formatted text in a word-processed file). Selecting this option 
means Mail OnNet will select the most complex part for which the configuration file has a conversion 
defined.This is the default.

4. Select Disable Warnings for MIME Non-Conformity if you do not want to receive warnings of any 
problems as Mail OnNet converts a message from MAPI to MIME format.

5. When you are satisfied with the settings, choose OK.
--or--
Choose Cancel to cancel your changes and accept the defaults.

Related Topics
Configuring the Retrieving of POP2 Messages
Configuring the Retrieving of POP3 Messages



Setting Up MIME Conversions for the Message Store

The MIME Message Store Configuration dialog box lets you configure the way MIME messages are 
handled in the message store.
When messages are received by Mail OnNet, they are saved in the message store without any 
conversions being made. This means that they must be converted to MAPI format when they are read. 
Mail OnNet has default conversions, but if you are an experienced electronic mail (e-mail) user, you can 
also use your own conversion configuration files. 
Mail OnNet allows you to define two separate configuration files: a User configuration file and a System 
configuration file. When you open a read window to read a message, the Mail OnNet messaging system 
searches your User configuration file first, then your System configuration file, and finally the Mail OnNet 
defaults, until it finds a conversion for the type of message being read.
Note:    You can specify either separate conversion configuration files for retrieving, sending, and storing 
messages in the message store, or one conversion file for all of these activities. The MIME and MAPI 
Conversion Files help topic describes the format used in conversion files.

To set MIME to MAPI conversions for the message store
1. Choose MIME in the Locations dialog box to display the MIME Message Store Configuration dialog 

box.
2. Under Enter MIME conversion configuration filenames, type the full path and filenames of your 

conversion files in the System File and User File boxes.
--or--
If you decide to use the Mail OnNet default conversion files instead, do not type anything into these 
boxes.

3. Under Type Handling, select the secondary character set (or enter the name of a character set) that 
you want to use in the MIME message for any text that is not US-ASCII. Mail OnNet recognizes US-
ASCII and ISO-8859-1 to ISO-8859-9, which are the character sets recommended in the MIME 
Request For Comment document (RFC 1521).

4. MIME messages can hold alternative forms of the same data in a message so that the receiving 
system can choose the format that suits it best. When you receive such a message, Mail OnNet has to
select which version to use. Under Choose MIME types, select one of the following options:
Configuration File Order. This option uses the order defined in the conversion configuration 
file. Order refers to the order in which conversions occur in the file; the earlier they occur in the file, the
higher their priority.
E-mail Message Order. This option uses the order of parts in the message itself as the basis for 
deciding which part to use. The recommended order of parts in a MIME message goes from simplest 
(for example, plain text) to most complex (for example, formatted text in a word-processed file). 
Selecting this option means Mail OnNet will select the most complex part for which the configuration 
file has a conversion defined. This is the default.

5. Under Do Not Show Warnings For, select any warning you do not want to receive if Mail OnNet has a 
problem converting your message from MAPI to MIME format.

6. When you are ready, choose OK.
--or--
Choose Cancel to make no changes and accept the defaults.

Related Topics
Providing Basic User Information
Specifying Locations for the Address Book and Message Store



Changing Your Mail OnNet Password

Use the Change Password dialog box to give yourself a new password for starting Mail OnNet at your PC.
Note:    The password for providing access to your messages on the POP mail server cannot be changed 
from this dialog box. To obtain a new password for the POP mail server, contact your system 
administrator or Internet service provider. If you do get a new password for the POP mail server, enter the
new password in the POP2 or POP3 Retrieve Mail settings dialog box, so that Mail OnNet has 
authorization to retrieve your messages from the server.

To change your password
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. Choose Password in the User Information dialog box to display 
the Change Password dialog box.

2. In the New Password box, delete your current password, which appears in the box as a string of 
asterisks (*) to prevent others from learning your password as it displays on the screen.

3. Type your new password in the New Password box.
4. In the Confirm Password box, type your new password again to verify that you know it - it will also 

appear as a row of asterisks (*).
5. When you are satisfied with your password, choose OK.

--or--
Choose Cancel to keep your current Mail OnNet password and return to the User Information dialog 
box.

Related Topics
Logging on to Mail OnNet
Providing Basic User Information
Requirements for Mail OnNet Configuration



Specifying Locations for the Address Book and Message Store

Use the Locations dialog box to specify alternate locations for both the address book and message store 
files.

To specify alternate locations for the address book and message store
1. Choose Mail Configuration from the Settings menu, enter your username and password in the Mail 

Logon dialog box, then choose OK. Choose Locations in the User Information dialog box to display the
Locations dialog box.

2. In the Address Book box, type the full pathname of the directory that will store your address book. 
Note that the default or current location appears in the box when the dialog box first appears.

3. In the Message Store box, type the full pathname of the directory that will hold your message store. 
Note that the default or current location appears in the box when the dialog box first appears.

4. To redisplay the Address Book Conversion dialog box during startup of Mail OnNet, select the Display 
Convert Address Book Dialog on Next MAPI Logon option.

5. To display the MIME Message Store Configuration dialog box, choose MIME.
6. When you are satisfied with the information you have provided, choose OK.

--or--
Choose Cancel to accept the default locations and return to the User Information dialog box.

Related Topics
Logging on to Mail OnNet
Providing Basic User Information
Requirements for Mail OnNet Configuration
Setting Up MIME Conversions for the Message Store



IP Address
A number of the form n.n.n.n (where each n is a value in the range 0 to 255) that uniquely identifies a 
computer on the Internet. The Internet Protocol is defined in RFC 791.



The File Menu

Use the File menu to save or print messages, signatures, or forms, check for new mail, or exit from Mail 
OnNet. The Save As, Print, and Check Mail commands also appear on the toolbar.

Use this command To do this
Save As Save the currently displayed message, signature, or form to a text file by using 

the Windows Save As dialog box.
Print Print the currently displayed message, signature, or form.
Print Preview Preview what your message, signature, or form will look like when it is printed. To

change the font used for printing, choose Set Printer Font from the View menu.
Page Setup Set up the pages of your print job before sending it to your selected printer.
Print Setup Change the setup of your selected printer or select a different printer by using the

Windows Print Setup dialog box.
Check Mail Have Mail OnNet check whether new mail has arrived for you on the mail server, 

and if so, retrieve the mail for you. Mail OnNet checks for new mail automatically 
after you first log in. After the initial check is complete, Mail OnNet will check for 
new mail at regular intervals, as specified by the Check for new mail every N 
minutes option on the POP2 or POP3 Retrieve Mail Settings dialog box.

Exit Exit from Mail OnNet. If you have any unsaved Compose windows open, you will 
be prompted to specify whether you want to save them as text files. When you 
next start Mail OnNet, any message list windows that you had open when you 
exited will be restored.



Page Setup

To change the information given in the page header and footer of a printed message, choose Page Setup 
from the File menu.
In the Header or Footer boxes of the Page Setup dialog box, enter the text that will appear on the pages 
of any printed message. You can insert codes into the text in the boxes; the codes let you print 
information that is associated with the message. For example, if you enter The subject of this 
message is &Subject. into the Header box before you print a message whose subject is Reports, the
printed page of the message has the page header The subject of this message is Reports.

This code Is replaced by the
&Cc Addresses of people who were sent copies of the message.
&CurrTme Time when the message is printed.
&Date Time and date that the message was submitted.
&Name Name of the sender.
&PageNum Page number.
&Subject Subject of the message.
&To Addressee of the message.

Related Topic
Setting the Printer Font
The File Menu



    Form
If you frequently send messages that usually have the same content or structure, such as an 
expenses claim to your corporate home office or an agenda for a regular meeting, you can create a 
form and use it as a template to make such tasks more efficient. Once you have created a form, you 
can use it over and over again as a message template.



The Edit Menu

The Edit menu lets you edit the text in the body of your messages. The Cut, Copy, Paste, Delete, and 
Find commands also appear on the toolbar.

Use this command To do this
Undo Reverse the effect of the last change that you made to a message. Undo 

replaces deleted or cut text, or removes added or pasted text, whichever was the 
last operation. You cannot undo changes once they have been saved.

Cut Remove selected text from a Form, Signature, or Compose window and places it 
on the Windows Clipboard. Once you have placed text or an object on the 
Windows Clipboard, you can paste it into another Mail OnNet window or another 
application document. 
Note:    You cannot cut text from a Read window.

Copy Make a copy of selected text from a Form, Signature, Compose, or Read window
and place the copy on the Windows Clipboard, without removing text from the 
original window. Once you have placed text on the Windows Clipboard, you can 
paste it into another Mail OnNet window or another application document.

Paste Replace selected text with text from, or insert text from the Windows Clipboard 
into a Form, Signature, or Compose window.You can paste text that you have cut
or copied from the same Mail OnNet window, a different Mail OnNet window, or 
another application.
Note:    You cannot paste text into a Read window.

Delete Delete selected text from a Form, Signature, or Compose window.
Note:    You cannot delete text from a Read window.

Find Search for a string of text that you specify. Mail OnNet displays a different Find 
dialog box, depending on whether you are searching for text in a message or the 
message list window of a folder.

Find Next Search in any Compose or Read window for a string of text that you have 
previously specified in the Find dialog box. To use Find Next, put your cursor in 
the text of a message, then choose Find Next from the Edit menu. Mail OnNet 
searches the text again for the same string, using the same Match Case setting 
and same search direction that you have specified in the Find dialog box.

Replace Replace a string of text in the body of a message with the string of text that you 
specify on the Replace dialog box.
Note:    You can use Replace only on text in a Compose window.

Import Text Insert text into the body of a Compose window message from a file you select in 
the Windows Open File dialog box.

Deselect All De-select all of the text in the body of the current message.
Select All Select all of the text in the body of the current message:



Replace

To replace text in a message, put the cursor in the text of the message, then choose Replace from the 
Edit menu to display the Replace dialog box. The Replace command is active only if you put the cursor in 
the text of a message in a Compose window. 

To use this feature Do this
Find What Type the string of text that you want to find in the message.
Replace With Type the text you want to insert into the message in place of the found text.
Match Case Select Match Case only to find text with exactly the same pattern of upper- and 

lowercase letters. 
Note: If the text in the Replace With box begins with a lowercase letter, but 
Match Case is not selected, the capitalization of the highlighted message text 
that you plan to replace will not change. That is, the Replace command replaces 
text correctly, whether it occurs at the beginning or in the middle of a sentence.

Choose this button To do this
Find Next If you want to select which of the occurrences of the found text will be replaced 

by your replacement text, choose Find Next to search for the next occurrence of 
the found text. Once Mail OnNet locates the next occurrence, it scrolls the 
window to the next occurrence and highlights it. If you want to replace this 
occurrence, choose Replace.If you do not want to replace this occurrence, but 
would rather search for the next occurrence, choose Find Next.

Replace Choose Replace to remove the highlighted text in the message that matches the 
text in the Find What box and replace it with the text from the Replace With box.

Replace All Choose Replace All to search for all occurrences of the found text, then replace 
each occurrence with the replacement text.

Cancel Return to the Compose window.

Related Topic
The Edit Menu



Finding Text in a Message

To find a string of text in the body of a message, place the cursor in the message body, then choose Find 
from the Edit menu or the toolbar to display the Find dialog box.

To use this feature Do this
Find What Type the string of text that you want to find in the message body.
Match Case Select Match Case only to find text with exactly the same pattern of upper- and 

lowercase letters. 
Direction Choose Up to search backward from the location of your cursor in the message 

text. Choose Down to search forward from the cursor position.

Choose this button To do this
Find Next Choose Find Next to search for the text in the Find What box. Once Mail OnNet 

locates the text, it scrolls the window to the text and highlights it. Choose Find 
Next again to find the next occurrence of the text.

Cancel Close the Find dialog box and return to the currently open window.

Related Topic
Finding Text in a Message List Window
The Edit Menu



Finding Text in the Message List Window of a Folder

To determine which messages in a message list window contain a specific string of text, open the 
message list window of any of your folders (such as the In-Tray folder), then choose Find from the Edit 
menu or the toolbar to display the Find dialog box. This approach highlights any messages in the 
message list window that contain the text you want to find.

To use this feature Do this
Find Type the string of text that you want to find in the message list.
Find In Select from one of the following search options:

Sender Name (in the From: message header)
Subject
Message Body
Date

Match Case Select Match Case only to find text with exactly the same pattern of upper- and 
lowercase letters. 

Choose this button To do this
OK Return to the message list window to find the specified string of text in the 

selected area.
Cancel Close the Find dialog box and return to the currently open window.

Related Topic
Finding Text in a Message
The Edit Menu



The View Menu

Use the View Menu to control the display and printing of your messages in Mail OnNet, and to move 
between messages. The Next and Previous commands also appear on the toolbar.

Use this command To do this
Next Select the next folder in the Message Store window, or select the next message 

in a Message List or Read window. 
Note:    If a Read window is displayed, selecting Next causes the next message 
from the current message list to be displayed in the same Read window.

Previous Select the previous folder in the Message Store window, or select the previous 
message in a Message List window or Read window. 
Note:    If a Read window is displayed, selecting Previous causes the previous 
message from the current message list to be displayed in the same Read 
window.

Toolbar Toggle between displaying or not displaying the toolbar.
Status Bar Toggle between displaying or not displaying the status bar.
Set Printer Font Set the printer font used for the currently open window or for new windows. You 

can toggle between Set Printer Font and Mirror Display Font.
Mirror Display Font Set the printer font to be identical to the display font.
Word Wrap Set lines of message text to wrap to the next line when their length is longer than 

the width of a Read or Compose window.



Setting the Printer Font

To set the printer font used to print the body of a message, signature, or form, choose Set Printer Font 
from the View menu to display the Font dialog box. You can toggle between Set Printer Font and Mirror 
Display Font.

In this list box Select
Font The font you want to use to print the message, signature, or form.
Font Style One of these font styles: Regular, Italic, Bold, or Bold Italic. he styles available 

depend on which font is selected in the Font box.
Size The point size of the font. The point sizes available depend on which font is 

selected in the Font box, but you can type whatever size you want.
As you select a font, font style, and font size, the effects of your selections appear in the Sample box. 
Choose OK when you are finished setting the printer font.
You can choose a different printer font independently for each window. Once you have chosen a printer 
font, it becomes the default printer font used for new windows until you either select a new font or choose 
Mirror Display Font from the View menu.
Note: The font is associated with the current window, not the message: if you close a window and open a 
new window for the same message, the new window will use the current default printer font, which may 
not be the font that was last associated with the old window.

Related Topic
Mirroring the Display Font
Page Setup



Mirroring the Display Font

To use the same font to print a message as you are using to display it in a window, choose Mirror Display 
Font from the View menu. You can toggle between Set Printer Font and Mirror Display Font.
Note: The Mirror Display Font setting is associated with the current window, not the message. If you close
a window and open a new window for the same message, the new window will use the current setting, 
which may not be the setting that was last associated with the old window.

Related Topic
Setting the Printer Font



Using Word Wrap

You can decide how messages should be displayed if their line length is longer than the width of the Read
or Compose windows. If Word Wrap is turned on, a new line is started whenever the message reaches 
the right-hand side of the window; there is no horizontal scroll bar because all of the message can be 
read within the width of the window.

If Word Wrap is turned off, a new line is started only if there is a carriage return character in the message.
Some of the message may be hidden beyond the right-hand side of the window, so you must use the    
horizontal scroll bar to read across the entire line.

Choose Word Wrap from the View menu to turn word wrapping on or off. The default word wrap settings 
for new Read and Compose windows are set on the Read Options and Compose Options dialog boxes 
(from the Settings menu). 
If Word Wrap is selected for a Compose window, you can also use the Compose Options dialog box and 
the Options button in the Compose window to select Force Hard Returns, which determines whether the 
line endings should be transmitted as actual line breaks when the message is sent.
Note: You can choose a different Word Wrap setting independently for each window. The Word Wrap 
setting is associated with the current window, not the message. If you close a window and open a new 
window for the same message, the new window will use the current setting, which may not be the setting 
that was last associated with the old window.



The Folders Menu

Use the Folders menu to organize your folders and messages.
Folders can contain messages or other folders in the same way that a directory can contain files or other 
directories. 
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Use this command To do this
New Create a folder.
Open Open the message list for the currently selected folder in the Message Store 

window. You can also double-click the folder in the Message Store window.
Move Move a folder and its contents to another folder.
Copy Copy a folder and its contents to another folder.
Rename Rename a folder.
Delete Delete a folder and its contents. If you have set the Confirm on Delete option on 

the User Preferences dialog box (chosen from the Settings menu), you will be 
prompted to confirm that you want to delete the folder and its contents.
Note:    You cannot create, copy, move, rename, or delete the In-Tray, Out-Tray, 
or Sent folders.



Creating a Folder

To create a folder
1. Select the folder in the Message Store window below which you want to place the new folder.
2. Choose New from the Folders menu to display the New Folder dialog box.
3. In the Name box, type the name of the new folder. The name may be no longer than eight 

alphanumeric characters, and cannot contain blank spaces.
4. Choose OK to return to the message store.
If you create two or more folders below the same folder, Mail OnNet sorts the folders alphanumerically. If 
you create your folder in the wrong location, select the folder, then move it to where you intended to place
it.
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Related Topics
Copying a Folder
Deleting a Folder
Drag and Drop
The Folders Menu
Moving a Folder
Renaming a Folder
Saving to a Folder
Selecting a Folder



Copying a Folder

To copy a folder and its contents
1. Select the folder that you want to copy in the Message Store window.
2. Choose Copy from the Folders menu to display the Copy Folder dialog box.

The folder named by From: is the one that will be copied.
3. In the To: box, select the folder to which you want to copy the folder. The folder and its contents 

(messages and other folders) will be copied to the folder selected in the To: box.
4. Choose OK to return to the main window.
You can also copy folders using drag and drop. You cannot copy the In-Tray, Out-Tray, or Sent folders.
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Related Topics
Creating a Folder
Deleting a Folder
Drag and Drop
The Folders Menu
Moving a Folder
Renaming a Folder
Saving to a Folder
Selecting a Folder



Moving a Folder

To move a folder and its contents
1. Select the folder that you want to move in the Message Store window.
2. Choose Move from the Folders menu to display the Move Folder dialog box.

The folder named by From is the one that will be moved.
3. In the To: box, select the folder to which you want to move the folder. The folder and its contents 

(messages and other folders) will be copied to the folder selected in the To: box.
4. Choose OK to return to the main window.
You can also move folders using drag and drop. You cannot move the In-Tray, Out-Tray, or Sent folders.
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Related Topics
Copying a Folder
Creating a Folder
Deleting a Folder
Drag and Drop
The Folders Menu
Renaming a Folder
Saving to a Folder
Selecting a Folder



Renaming a Folder

To rename a folder
1. Select the folder that you want to rename in the Message Store window.
2. Choose Rename from the Folders menu to display the Rename Folder dialog box.

The folder in the From: box is the one that will be renamed.
3. In the To: box, type the name with which you want to rename the folder. The name may be no longer 

than eight alphanumeric characters, and cannot contain blank spaces.
4. Choose OK to return to the main window.
You cannot rename the In-Tray, Out-Tray, or Sent folders.
Caution:    Folders can contain messages or other folders in the same way that a directory can contain 
files or other directories. Although you will probably be able to find and identify the directories and files 
used to store Mail OnNet folders and messages, use only the Mail OnNet commands and operations to 
manipulate folders and messages. If you use another tool, such as Windows File Manager, to manipulate 
your Mail OnNet folders and messages, you can cause an error in Mail OnNet, because it keeps track of 
messages by storing additional information about them in the directory for each folder.

Related Topics
Copying a Folder
Creating a Folder
Deleting a Folder
Drag and Drop
The Folders Menu
Moving a Folder
Saving to a Folder
Selecting a Folder



The Message Menu

Use the Message menu to manage your messages. The Compose Message, Delete, Reply, Save to File, 
and Save to Folder commands also appear on the toolbar.

Use this command To do this
Compose Message Compose a mail message.
Read Read the currently selected message.
Delete Delete the currently selected message(s). If you have selected the Confirm on 

Delete option on the User Preferences dialog box, you will be prompted to 
confirm that you want to delete the message.

Queue Put the message that you just prepared in the Compose window in the Out-Tray 
folder and keep it there until Mail OnNet next connects with your mail server. This
command is available only when you are using Mail OnNet in offline mode.

Deliver Causes Mail OnNet to connect with your mail server to send any messages that 
you have queued in the Out-Tray folder for delivery. This command is available 
only when you are using Mail OnNet in offline mode.

Send Send the currently selected message.
Forward Forward the currently selected message.
Reply Reply to the currently selected message.
Save to File Save the currently selected message to a text file.
Save to Folder Save the currently selected message to a folder.



Deleting a Message and Its Attachments

To delete the currently selected message in a Read window or a Message List window, choose Delete 
from the toolbar or the Message menu. If you have selected the Confirm on Delete option in the User 
Preferences dialog box, you will be prompted to confirm that you want to delete the message.
Note:    When you delete a message, you also delete its attachments.



The Settings Menu

Use the Settings menu to customize your Mail OnNet environment.

Use this command To do this
Compose Options Display the Compose Options dialog box to customize the composing of 

messages.

Read Options Display the Read Options dialog box to customize the display of messages in the
Read window.

Forward Options Display the Forward Options dialog box to customize the forwarding of 
messages.

Reply Options Display the Reply Options dialog box to customize your replies to messages.

Preferences Display the Preferences dialog box to customize your Mail OnNet environment.

Mail Configuration Display the User Information dialog box to change your Mail OnNet configuration.

Skip Logon When selected, this menu option lets you skip logging on with the Mail Logon 
dialog box each subsequent time that you start Mail OnNet. 

Note:    This option is unavailable if you configure more than one user of Mail 
OnNet on your system.

Online Mode Use Mail OnNet in Online mode. In Online mode, Mail OnNet is connected to 
your mail server so that you can send and receive mail without having to cause 
Mail OnNet to connect to your mail server manually. This is the default mode.

Offline Mode Use Mail OnNet in Offline mode. In Offline mode, Mail OnNet connects with your 
mail server to send mail only when you choose Deliver from the Message menu 
or toolbar.

Tab Stop Set the tabular spacing for your text.

Font Display the standard Windows Set Font dialog box to set the display font for Mail 
OnNet windows.



Setting Options for Composing Messages

Choose Compose Options from the Settings menu to display the Compose Options dialog box. The 
compose options specify defaults used for new Compose windows. When you are finished making your 
selections, choose OK to return to the Mail OnNet main window.

Select this option To do this
Urgent, Normal, or Low Priority

Change the priority of a message. These settings have no effect on how long it 
takes a message to reach its destination. On mail systems supporting priorities, 
the priority will be shown for the message according to how that mail system 
represents message priority information. 

For example, in Mail OnNet, the priority of a received, unread message is shown 
in a message list window by the color of the message icons: a red envelope (with
exclamation point) represents urgent priority; a yellow envelope represents 
normal priority; and a light blue envelope represents low priority.

Delivery Receipt Receive notification that the message has arrived at its destination. If you receive
a delivery receipt message, you can be certain that the message has been 
received on the host system of the recipient. Only systems that are running 
programs like the UNIX Sendmail program will respond to a request for a delivery
receipt; therefore, if you fail to get a delivery receipt, do not assume that your 
message was not received.

Read Receipt Receive notification that your message has been read at its destination host. If 
you receive a read receipt message, you can be certain that the recipient has 
read your message. Not all mail systems or recipients will respond to a request 
for a read receipt; therefore, if the system of the recipient fails to send back a 
read receipt, do not assume that your message has not been read. Mail OnNet 
can receive read receipts from other mail systems, but does not send read 
receipts.

Fixed Size for Message Input N Characters

Sets each line of text in the message body to be no longer than the number of 
characters specified. 70 characters is the default and is suitable for most mail 
systems that receive your messages. You must specify at least 25 characters for 
this option.

Use Word Wrap Display messages in the Compose window whose lines of text are wider than will
fit inside the window. When the word wrap feature is set, all of the lines of text in 
the message body wrap to the next line if necessary to fit within the Compose 
window, so no horizontal scroll bar is needed. When the word wrap feature is not 
set, you can read the end of lines that have gone beyond the right-hand edge of 
the Compose window by using the horizontal scroll bar.

If you want to change the word wrap setting for a Compose window after opening
it, choose word wrap from the View menu.

Force Hard Returns Replace the soft returns (put in by Mail OnNet to display the message within the 
width of a Compose window) by hard returns when the message is transmitted. If
this setting is used, the message when sent will contain a carriage return 
wherever a line of text reached the right-hand Compose window boundary and 
was forced to continue on the next line. 

This setting retains the appearance of the message as it was displayed in the 
Compose window, so that the mail system of your recipient displays the lines of 
text in the received message body as they once were in the Compose window. If 



the formatting of your message is important, for example if it has tables of 
numbers, and you want the receiver of your message to see exactly what you 
see in the Compose window, either select Force Hard Returns, or put in carriage 
returns manually.

Close Compose Window

Close the Compose window automatically after you have sent the message.

Save to Folder Save a copy of messages you send automatically to the folder specified in the 
text box. When you select this option, Mail OnNet displays the Select Folder 
dialog box to let you select the folder. By default, the Sent folder is used.

Bcc Send blind carbon copies of the message to the names or addresses specified in 
the text box. Recipients who are on the Bcc: list will be sent a copy of the 
message, but their names or addresses will not appear in the headers of the sent
message.

Reply To Specify the name or e-mail address to which you want replies sent when anyone 
replies to your mail. What you specify appears in the Reply To header of your 
sent messages. 

You can override the defaults for a specific message by choosing the Options button in the    Compose 
window of the message. Doing so displays the Local Compose Options dialog box.

Related Topics
Setting Forward Options
Setting Local Compose Options
Setting Read Options
Setting Reply Options
Setting Your Mail OnNet Preferences



Setting Options for Reading Messages

Choose Read Options from the Settings menu to display the Read Options dialog box. The read options 
specify the defaults used for displaying Read windows. When you are finished making your selections, 
choose OK to return to the Mail OnNet main window.

Select this option To display
Summary of Headers Brief header information (From:, Subject:, To:, Cc:, and Date:) in separate, 

scrollable boxes at the top of Read windows.

Full Headers All of the header information displayed in a scrollable box at the top of Read 
windows. The header information can be very verbose for MIME messages, so 
you may not want to use this option frequently.

Use Word Wrap in Read Window

Message text lines using word wrapping in Read windows.

If you want to change the word wrap setting for a Read window after you have 
opened it, choose Word Wrap from the View menu.

Related Topics
Setting Compose Options
Setting Forward Options
Setting Local Compose Options
Setting Reply Options
Setting Your Mail OnNet Preferences



Setting Options for Forwarding Messages

Choose Forward Options from the Settings menu to display the Forward Options dialog box. The forward 
options specify the defaults used when forwarding messages. When you are finished making your 
selections, choose OK to return to the Mail OnNet main window.

When you forward a message, a Compose window opens with the forwarding Begin With string at the top 
of the window, followed by the forwarded message, each line of it preceded by any forwarding Indent With
string, and concluding with the forwarding End With string. You can edit any of these features in the 
Compose window.

In this option box Type this information
Begin With Any text that you want to appear before the forwarded message. You may want 

to separate the message you are forwarding from any other text you want to 
include by using a string of repeated characters, such as an asterisk (*) or an 
underscore (_). Alternatively, you can enter text that you want to have appear 
before any forwarded message. 

You can also use any of the codes listed in this topic to include information about 
the original message within the Begin With string. For example, if you type 
&Name said on &Date: into the Begin With box, and then you forward a 
message from Jane Doe, the Begin With string of your forwarded message would
state this: Jane Doe said on July 4, 1995:

End With Any text that you want to use to conclude the forwarded message. You may want 
to separate the message you are forwarding from other text following the 
forwarded message by using a string of repeated characters, such as an asterisk 
(*) or a right angle bracket (>). You can also use the codes listed in this topic to 
include information about the original message within the End With string.

Indent With Any characters that you want to appear at the beginning of each line of the 
forwarded message (the indent characters). A common convention is to use the 
right angle bracket (>) as an indent character.

You can use the following codes to insert information about the original message in a Begin With, End 
With, or Indent With string:

This code Is replaced by
&Name The name of sender of the original message.
&Date The date on which the original message was submitted.
&Subject The subject title of the original message.

Related Topics
Setting Compose Options
Setting Local Compose Options
Setting Read Options
Setting Reply Options
Setting Your Mail OnNet Preferences



Setting Options for Replying to Messages

Choose Reply Options from the Settings menu to display the Reply Options dialog box. The reply options 
specify the defaults used for replying to messages. When you are finished making your selections, 
choose OK to return to the Mail OnNet main window.

When you reply to a message by choosing Reply from the Message menu or toolbar, then select one of 
the Include Message options, a Compose window opens with the reply Begin With string at the top of the 
window. This is followed by the included message preceded by the reply indent string added to the 
beginning of each line, and is followed by the reply End With string. You can edit any of these features in 
the Compose window.

In this box Type this information
Begin With Any text that you want to have appear before the included original message (the 

Begin With string).You may want to separate the message you are including from
the other text in your reply by using a string of repeated characters, such as the 
asterisk (*) or the underscore (_). 

You can also use the codes described in this help topic to include information 
about the original message in the Begin With string. For example, if you type In 
reply to &Name on &Date: into the Begin With box, then reply to a 
message from Jane Doe, the Begin With string states this: In reply to Jane
Doe on July 4, 1995:

End With Any text that you want to have appear after the included original message (the 
End With string). You may want to separate the message you are including from 
the other text following the included message by using a string of repeated 
characters, such as the asterisk (*) or the right angle bracket (>). You can also 
use the codes described in this help topic to include information about the original
message in the End With string.

Indent With Any characters that you want to have appear at the beginning of each line of the 
included message (the indent characters). A common convention is to use the 
right angle bracket character (>) as an indent string. Often, the left angle bracket 
character (<) is placed before lines written in response to lines that begin with the
right angle bracket. When replies are made to replies, several indentations of 
angle brackets can appear that identify the order in which a conversation is being
conducted.

This code Is replaced by
&Name The name of sender of the original message.
&Date The date on which the original message was submitted.
&Subject The subject title of the original message.

To set the Reply button on the toolbar
To set the reply button to use the same Reply To setting each time you select it from the toolbar, select 
one of the following options under Reply Button Means Reply To. These options take effect only if you 
choose Reply from the toolbar. If you choose Reply from the Message menu, the options appear on a 
menu.

Sender You want the reply sent only to the sender.

Sender - Include Message
You want the reply sent only to the sender and you want to include the original 
message.



All You want the reply sent to the sender and anyone who was on the Cc list.

All - Include Message
You want the reply sent to the sender and anyone who was on the Cc list, and 
you want to include a copy of the original message.

Related Topics
Setting Compose Options
Setting Forward Options
Setting Local Compose Options
Setting Read Options
Setting Your Mail OnNet Preferences



Setting Tab Stops

The number of tabs that you specify is used to set the number of spaces between tabular stops across 
the window. When you press TAB to enter a tab into text in a Compose window, the cursor moves to the 
next tab stop. Changing the tab stop setting in a Read window changes the alignment of any tabbed text.

Each window can have its own setting for the tab stop spacing, but the same spacing is used for all of the 
text in that window. Changing the tab stop setting after you have entered tabs changes the spacing of the 
text you have already entered, as well as the spacing of new text.

Use a fixed width font, such as Courier, if the vertical alignment of text in your message is important (for 
example, if you want your message to show columns of numbers). Note that the recipient may not have a 
mail system that supports variable fonts like Mail OnNet, and may only be able to use a fixed width font to
read your message. 

Note:    The Set Tab Stops dialog box does not set the tabular stops in a sent message.

To set the number of characters that are represented by a tabular stop in a compose or read 
window
1. Choose Tab Stops from the Settings menu to display the Set Tab Stops dialog box. 

2. In the Tab Stops text box, type a number, from the range 1 through 16 inclusive, that specifies the 
number of spaces between tab stops, then choose OK to return to the Mail OnNet main window.

Mail OnNet displays a warning if you enter a number larger than 16. When you send a message that 
has tabs, the tabs will be replaced with the appropriate number of spaces.



Setting the Display Font

To set the display font of a window type
1. Select the type of window (for example, a Message List window) whose display font you want to set, 

then choose Set Font from the Settings menu to display the Font dialog box. 

2. In the Font box, select the font you want to use to display the message, signature, or form.

3. In the Font Style box, select one of these font styles: Regular, Italic, Bold, or Bold Italic. The styles 
available depend on which font is selected in the Font box.

4. In the Size box, select the point size of the font. The point sizes available depend on which font is 
selected in the Font box, but you can type whatever size you want.

As you select a font, font style, and font size, the effects of your selections appear in the Sample box. 
Choose OK when you are finished setting the display font to return to the Mail OnNet main window.

5. Choose OK to set the display font to your selections and return to the previous window. All windows of 
that type will display that font. 

Notes:    Each type of window can have a separate font, except for the Compose and Read windows, 
which will use the same font.

When choosing a font, note that the font is used only in your display; it is not transmitted with the 
message. Any of your formatting that relies on the spacing of text may be lost. If the formatting is 
important (for example, if you want to align items or numbers in columns), use a fixed width font, such as 
Courier. 



The Tools Menu

Use the Tools menu to manage your automatic tasks, address book, forms, and signatures.

Use this command To do this
Tasks Display the Task Manager dialog box to manage your automatic tasks.

Address Book Display the Address Book dialog box to manage your address book.

Forms Display the Select a Form dialog box to manage your form files.

Signatures Display the Select a Signature dialog box to manage your signature files.

Spelling Display the Word Not Found in Dictionary dialog box to correct any misspelled 
words that appear in your message text. The dialog box does not appear if your 
message contains no misspelled words.



Searching the Address Book

Choose Find in the Address Book dialog box to display the Find dialog box.

In the Find box, type the string of text that you want to find. Enter a part of the name or address that you 
know is correct. 

For example, if you want to send a message to Michael Jones, but you are not certain whether his name 
is in the address book under Jones, Michael, or E M Jones, type Jones to search through all entries 
that contain Jones somewhere in the entry.

Select this option To do this
Display Name Search using the name displayed in the address book, rather than search for the 

e-mail address.

E-mail Address Search for the e-mail address of the person rather than search for the display 
name.

Anywhere in String
Search for part of a name (or address) anywhere within each entry in your 
address book. 

From the Start of the String
Search only from the beginning of names or addresses in your address book.

For example, if you search for John and select Anywhere in String, you will find not only John Smith, 
but also Bill Johnson. However, if you search for John and select From the Start of the String, you will
find only John Smith.

Choose this button To do this
Close Close this dialog and return to the Address Book dialog box.

Cancel Cancel the search and return to the Address Book dialog box.

Find Next Begin searching the address book. If a matching name is found, Mail OnNet 
highlights the name in the Name box of the Address Book dialog box.

If the highlighted name is the one that you are searching for, choose OK; 
otherwise, choose Find Next to search further down the list of entries.

Related Topic
Using the Address Book



MIME and MAPI Conversion Files

When you send a message, it has to be converted from the MAPI format to the MIME format. Mail OnNet 
comes with default conversions, but if you are an experienced network e-mail user, you can also write 
your own conversion configuration files. Mail OnNet allows you to define two separate configuration files: 
a User configuration file and a System configuration file. 
When a conversion is to be made, Mail OnNet searches for conversions that match the source type. 
Some of the conversions may contain a test, which is then applied to the source to determine if the 
conversion can be applied. If there is more than one conversion matching the source type and passing 
any tests, the target type, if it is known, is matched.
If there is more than one conversion with matching sources and targets, and with tests that succeed, the 
choice of conversion is decided by their priorities. Conversions in the User file have higher priority than 
any defined for the same types in the System file, which in turn have higher priority than the default 
conversions. Within a file, conversions appearing earlier in the file have higher priority than any occurring 
for the same types later in the file.
As well as specifying how a MAPI type is to be converted to a MIME type, and a MIME type to a MAPI 
type, the conversion configuration file can specify the encoding to be used.
Note that you can set up separate (or the same) conversion configuration files for receiving, sending, and 
storing messages in the message store. 
This topic defines the syntax used for conversion configuration files. Do not make changes unless you 
have the appropriate knowledge and level of understanding of your network and mail environments. Once
Mail OnNet has been set up, there should be no need to make any further changes to its configuration 
unless there are changes to the operating environment.

General Structure of Conversion Configuration Files
Configuration files are plain text files consisting of a series of configuration blocks separated by blank 
lines. Configuration blocks themselves must not contain any blank lines. Lines beginning with the number 
sign (#) are ignored, so they can be used for documenting the file with comments.
A configuration block can be one of three types, distinguished by beginning with a line consisting of
[INTERNAL CONV]
or
[EXTERNAL CONV]
or
[ENCODING]
The difference between external and internal conversion configuration blocks is that external conversion 
configuration blocks cannot use any of the built-in conversions, while internal conversion configuration 
blocks can use only the built-in conversions. Both types of conversion blocks are used to define the 
conversion of a MAPI to a MIME type and/or a MIME to a MAPI type. Encoding blocks are used to define 
how information is encoded in the transmitted message.

External Conversion Configuration Blocks
Following the [EXTERNAL CONV] line, there are two fields (lines) defining the MIME and MAPI types 
between which the conversion is defined. These lines have the form
MIME:  <mime type>
and 
MAPI:  <mapi type>
where <mime type> is the name of a MIME type (such as text/plain) and <mapi type> is the DOS file 
extension of the MAPI attachment (such as .TXT). The name of the MIME type can include a wildcard for 
subtypes. For example, text/* will match any MIME type whose primary type is text.
Following these lines, there must be a field (line) defining a MIME to MAPI or a MAPI to MIME 
conversion, or fields defining both. These fields have the form
MIMEtoMAPI:  <definition>
MAPItoMIME:  <definition>
where <definition> is a comma-separated list of one or more keywordvalue pairs:
<keyword1>: <value1>, <keyword2>: <value2>,......
Because commas are used to separate the keywordvalue pairs, they cannot be included in values. The 



keyword in each pair specifies a particular aspect of the conversion and the value defines how that aspect
should be handled.

MAPItoMIME Keywords and Values
Keyword Values
encoding: The value gives the encoding to be used to convert from MAPI to MIME. Possible

values:
7bit
8bit
quoted-printable
base64
binary
user conversions defined in a conversion configuration file (see later in this topic).
Default:    7bit
Example:    encoding: quoted-printable

binary: The value indicates whether or not the MAPI type is binary data. If it is not binary,
it is assumed to be textual and any form of linefeed (/r/n, /n or /r) is converted to a
/r/n sequence. Possible values:
yes
no
Default:    no (that is, textual)
Example:    binary: yes

conversion: The value is a template for the command line sequence to convert the MAPI type
to the MIME type. The following parameters can be used in this command line 
template:
%infile  This will be replaced by the input file for the conversion (the MAPI 
part to be converted).
%outfile    This will be replaced by the output file for the conversion (the MIME 
part to be sent).
%MAPItype    This will be replaced by the type of the MAPI part to be converted 
(the contents of the MAPI field in the conversion block).
%MIMEtype    This will be replaced by the type of the MIME part to be sent (the 
contents of the MIME field in the conversion block).
Example:  conversion: xcopy %infile %outfile
The <none> conversion, which does no conversion, can also be used.

typed conversion: This is the same as a conversion, except that the conversion program provides 
additional parameters to be placed (in MIME format) at the beginning of the part.

MIMEtoMAPI Keywords and Values
Keyword Values
TEST: This value is a list of <parameter>=<value> items, separated with a semicolon

(;), which the MIME part must have if the conversion is to be carried out. If the 
values in the list have to contain a comma (,) or semicolon (;), the whole value 
should be placed in double quotation marks.
Example:  TEST: param = test,xyz; charset=US_ASCII

CONVERSION: This is essentially the same as for MAPI to MIME with the addition of a MIME to 
MAPI specific parameter: %description,which will be replaced by the 
description, if any, given to the MIME part in the message.

Internal Conversion Configuration Blocks
Following the [INTERNAL CONV] line, there must be a field (line) defining either the MIME or MAPI type 
(not both) to be converted. This line has the form
MIME:  <mime type>
or
MAPI:  <mapi type>
Where <mime type> is the complete name of a mime type (such as text/plain) and <mapi type> is the



DOS file extension of the MAPI attachment (such as .TXT).
Following this lines, there must be a field (line) defining the MIME to MAPI conversion if the block is for a 
MIME type, or the MAPI to MIME conversion, if the block is for a MAPI type. These fields have the form
MIMEtoMAPI:  <definition>
MAPItoMIME:  <definition>
These fields have the same structure as for external conversions. However, a conversion value can only 
be one of the built-in conversions, which, with the exception of <none>, cannot be used with external 
conversions. 

MIME to MAPI Built-in Conversions
Definition Conversion
!text! Converts a MIME part to a MAPI .TXT type. If it is the first part in the message, 

and not too large, it will be the message text of the MAPI message; otherwise, it 
will be made an attachment.

!message! Converts what is assumed to be a MIME-compliant message to a MAPI 
message. 

!mixed! See !digest!
!parallel! See !digest!
!digest! These convert what is assumed to be a multipart/mixed, multipart/parallel, or 

multipart/digest MIME part to attachments of a MAPI message. If the multipart is 
itself a part of another multipart message, a new MAPI message is created and 
the parts attached to it; otherwise, the parts are attached to the top-level MAPI 
message.

!altern! Chooses the preferred alternative from what is assumed to be a 
multipart/alternative MIME message.

!octet! Converts an arbitrary MIME type to a MAPI attachment, using information 
contained in the MIME part to determine the type, or failing this, sets it to be a 
generic binary data type. This is the default for any unrecognized type.

<none> Does no conversion.

MAPI to MIME Built-in Conversions
Definition Conversion
!text! Converts a MAPI text part (message or attachment) to a MIME text/plain type. 

US-ASCII is used if possible; otherwise, the users secondary character set is 
used. The secondary character set is specified in the Mail OnNet Mime Send 
Setup and Mail OnNet Local Message Store MIME Configuration dialog boxes. 
This dialog box also allows you to force lines longer than a certain length to be 
broken up into shorter lines so they can be read more easily on a non-text-
wrapping terminal.

!octet! Converts an arbitrary MAPI type (not a MAPI object) and to an application/octet-
stream MIME message part.

<none> Does no conversion.

Encoding Blocks
Following the [Encoding] line, there must be a field (line) defining the name of the encoding to be used 
for MIME messages. This line has the form
NAME: <encoding name>
Following this field (line), there must be a field (line) defining a MAPI to MIME encoding or a MIME to 
MAPI decoding, or fields defining both.
These fields have the form
ENCODER: <coding method>
or
DECODER: <coding method>
Where <coding method> is a built-in coding method or a command line template for the coding (you 
can use the %infile and %outfile parameters for use with the command line template, as with 
conversions).



Examples
Encoder: uuenc %infile %{Filename} > %outfile
Decoder: uudec %infile > %outfile
Built-in Codings
!base64! Encodes or decodes data to or from base64 (see the MIME definition document 

RFC 1521 for details of the encoding).
!quotedp! Encodes or decodes data to or from quoted-printable (see the MIME definition 

document RFC 1521 for details of the encoding).
<none> Does no encoding or decoding.

Default Conversions
The following default conversions are defined in the Mail OnNet messaging subsystem. These are 
defined internally and do not follow all the rules required of conversions defined in conversion files. 
However, for convenience they are given here using a similar syntax, which introduces a [CONV] block. 
This combines the properties of internal and external conversions in that both source and target types are
given, as in an external conversion, and built-in conversions can be used, as in an internal conversion. 
The syntax is also extended to include the MAPI type *MSG, a generic MAPI message. Note that these 
extensions to the syntax are simply to allow the default conversions to be described simply and concisely;
they will not be recognized if you use them in a conversion file. 
The definitions also use a number of built-in conversions that are used by the default conversions, but 
cannot be used in a user-defined internal conversion. The following definitions are used for MAPI to MIME
conversions:
Definition Conversion
!message! Converts a MAPI message and its attachments to a MIME message.
!mixed! Converts a MAPI message and its attachments to a multipart/mixed MIME part.
!parallel! Converts a MAPI message and its attachments to a multipart/parallel MIME part.
!digest! Converts a MAPI message, which should have no message text, and its 

attachments, which should all be MAPI messages, to a multipart/digest MIME 
part.

With this extended syntax and these additional built-in conversions, the default conversions can be 
defined as follows:
[CONV]
MIME: message/rfc822
MAPI: *MSG
MIMEtoMAPI: conversion: !message!
MAPItoMIME: conversion: !message!
[CONV]
MIME: message/*
MAPI: *MSG
MIMEtoMAPI: conversion: !message!
[CONV]
MIME: multipart/mixed
MAPI: *MSG
MIMEtoMAPI: conversion: !mixed!
MAPItoMIME: conversion: !mixed!
[CONV]
MIME: multipart/parallel
MAPI: *MSG
MIMEtoMAPI: conversion: !parallel!
MAPItoMIME: conversion: !parallel!
[CONV]
MIME: multipart/altern
MAPI: .BIN
MIMEtoMAPI: conversion: !altern!
MAPItoMIME: conversion: !altern!
[INTERNAL CONV]



MIME: multipart/digest
MAPI: *MSG
MIMEtoMAPI: conversion: !digest!
MAPItoMIME: conversion: !digest!
[CONV]
MIME: multipart/*
MIMEtoMAPI: conversion: !mixed!
[CONV]
MIME: text/plain
MAPI: .TXT
MIMEtoMAPI: conversion: !text!
MAPItoMIME: conversion: !text!
[CONV]
MIME: text/richtext
MAPI: .TXT
MIMEtoMAPI: conversion: !text!
MAPItoMIME: conversion: !text!
[CONV]
MIME: text/simplemail
MAPI: .TXT
MIMEtoMAPI: conversion: !text!
MAPItoMIME: conversion: !text!
[EXTERNAL CONV]
MIME: audio/basic
MAPI: .AU 
MIMEtoMAPI: conversion: <none>
MAPItoMIME: conversion: <none>, binary: yes, encoding: base64
[EXTERNAL CONV]
MIME: image/gif
MAPI: .GIF
MIMEtoMAPI: conversion: <none>
MAPItoMIME: conversion: <none>, binary: yes, encoding: base64
[EXTERNAL CONV]
MIME: video/mpeg
MAPI: .MPG
MIMEtoMAPI: conversion: <none>
MAPItoMIME: conversion: <none>, binary: yes, encoding: base64
[EXTERNAL CONV]
MIME: application/postscript
MAPI: .PS
MIMEtoMAPI: conversion: <none>
MAPItoMIME: conversion: <none>, binary: no, encoding: 7bit
[CONV]
MIME: application/octet-stream
MAPI: .BIN
MIMEtoMAPI: conversion: !octet!
MAPItoMIME: conversion: !octet!



When Things Go Wrong with Mail OnNet

This topic describes some difficulties that you may experience when using Mail OnNet, and provides 
solutions for resolving those difficulties.

Sending and Receiving Mail
You cannot send mail from Mail OnNet.
You cannot send mail from a MAPI-aware application.
Mail OnNet cannot retrieve mail.
Mail OnNet retrieves many copies of the same messages each time it retrieves your mail.

Passwords
You forget your Mail OnNet password.
Mail OnNet prompts you to enter your POP2 or POP3 password.

Tasks
A task is not moving messages to the expected folder.
Task Tips

Electronic Mail Message Formatting and Printing
An equal sign (=) appears in the text of your sent messages.
You want to control the line length of your messages.
The font used in a printed message does not look as you expected.

Some Key Warning Messages
Rebuilding a Folder Index
Bad MIME Conversion in an E-mail Address
Unable to Find Details of Your Mail Server



You cannot send mail from Mail OnNet

Problems
When you send electronic mail, your messages are not received by the intended recipients. You may also
see the message Unable to find details of mail host when you log in to Mail OnNet.

Solutions
Confirm that your PC is connected to the mail server. Use the Ping application to determine whether you 
can contact the mail server. If you are not certain what the name of the mail server is, choose Mail 
Configuration from the Settings menu to display the User Information dialog box. Choose OK until you 
see the name of the SMTP server displayed in the Send Mail Settings dialog box.
If Mail OnNet cannot reach the server:

You may have entered the mail server hostname or domain name incorrectly. To correct an incorrect 
name, choose Mail Configuration from the Settings menu to display the User Information dialog box. 
Choose OK until you see the name of the SMTP server displayed in the Send Mail Settings dialog box.
Make certain that the name you specify in the SMTP Server box is comprised of both the correct 
hostname (such as "server10") and domain name (such as "xyz.com") for the server.
If you are certain that you are using the fully qualified server name, the name services provided by 
your network (such as DNS or NIS) may not be operating at the time that Mail OnNet attempts to 
resolve hostnames with IP addresses. As an alternative, you can change the name you specified for 
the mail server to its IP address. In the SMTP Server box, specify the IP address in place of the name 
of the server. Contact your Internet service provider or system administrator to obtain the IP address of
the SMTP server.

If Mail OnNet can reach the server:
Make certain that the only SPOOLER.EXE and MAPI.DLL files being used on your PC are those found
in your default directory for the OnNet 2.0 or Explore 2.0 products. If you find other SPOOLER.EXE or 
MAPI.DLL files on your PC, rename them or delete them, so that the only SPOOLER.EXE or 
MAPI.DLL that can be found in your PATH statement, WINDOWS directory, or Windows System 
directories are the ones that have been installed with Mail OnNet. 
After making these changes, restart Windows to ensure that your changes take effect.
If you have no additional copies of SPOOLER.EXE or MAPI.DLL, and can contact the server, check 
with your system administrator or Internet service provider. The mail server itself may be experiencing 
a problem.

Related Topic
When Things Go Wrong with Mail OnNet



You cannot send mail from a MAPI-aware application

Problem
You start a MAPI-aware application, but no Send command appears in the File menu.

Solutions
· Make certain that the WINDOWS\WIN.INI file contains the following section and parameter:

[MAIL]
MAPI=1
If you must edit the file to add this section and parameter, restart Windows afterwards so that your 
changes take effect.
Make certain that the only SPOOLER.EXE and MAPI.DLL files being used on your PC are those found
in your default directory for the OnNet 2.0 or Explore 2.0 products. If you find other SPOOLER.EXE or 
MAPI.DLL files on your PC, rename them or delete them, so that the only SPOOLER.EXE or 
MAPI.DLL that can be found in your PATH statement, WINDOWS directory, or Windows System 
directories are the ones that have been installed with Mail OnNet. 
After making these changes, restart Windows to ensure that your changes take effect.

Related Topic
When Things Go Wrong with Mail OnNet



Mail OnNet cannot retrieve mail

Problems
When you select Check Mail from the File Menu or the toolbar, or when Mail OnNet checks for new mail 
at startup, no messages are retrieved, even though you know to expect new messages. 
When you start Mail OnNet, you may also be prompted to enter your POP2 or POP3 password.

Solutions
Confirm that your PC is connected to the mail server. Use the Ping application to determine whether you 
can contact the mail server. If you are not certain what the name of the mail server is, choose Mail 
Configuration from the Settings menu to display the User Information dialog box. Choose OK until you 
see the name of the POP server displayed in the Retrieve Mail Settings dialog box.
If Mail OnNet cannot reach the server:

You may have entered the mail server hostname or domain name incorrectly. To correct an incorrect 
name, choose Mail Configuration from the Settings menu to display the User Information dialog box. 
Choose OK until you see the name of the POP server displayed in the POP2 or POP3 Retrieve Mail 
Settings dialog box. Make certain that the name you specify in the POP Server box is comprised of 
both the correct hostname (such as "server10") and domain name (such as "xyz.com") for the server.
If you are certain that you are using the fully qualified server name, the name services provided by 
your network (such as DNS or NIS) may not be operating at the time that Mail OnNet attempts to 
resolve hostnames with IP addresses. As an alternative, you can change the name you specified for 
the mail server to its IP address. In the POP Server box in the POP2 or POP3 Retrieve Mail Settings 
dialog box, specify the IP address in place of the name of the server.

If Mail OnNet can reach the server:
You may have selected the wrong mail retrieval protocol. Mail OnNet currently supports two mail 
retrieval protocols, POP2 and POP3. The default is POP3. The mail server you are connected to may 
not support POP3. Confirm which protocol you should be using with your system administrator or 
Internet service provider.
Make certain that the only SPOOLER.EXE and MAPI.DLL files being used on your PC are the ones 
found in your default directory for the OnNet 2.0 or Explore 2.0 products. If you find other 
SPOOLER.EXE or MAPI.DLL files on your PC, rename them or delete them, so that the only 
SPOOLER.EXE or MAPI.DLL    files that can be found in your PATH statement, WINDOWS directory, 
or Windows System directories are the ones that have been installed with Mail OnNet. 
After making this change, restart Windows to ensure that your changes take effect.
If you are using the correct protocol, have no additional copies of SPOOLER.EXE or MAPI.DLL, and 
can contact the server, check with your system administrator or Internet service provider. The mail 
server itself may be experiencing a problem.

Related Topics
When Things Go Wrong with Mail OnNet
Mail OnNet retrieves many copies of the same messages each time it retrieves your mail.
You cannot send mail from Mail OnNet.



Mail OnNet retrieves many copies of the same messages each time it retrieves 
your mail

Problem
You keep getting copies of all of your messages in the In-Tray folder, every time Mail OnNet retrieves your
mail.

Solution
You may need to change the After Getting Mail setting in the POP2 or POP3 Retrieve Mail Settings dialog
box. You can reset it by choosing Mail Configuration from the Settings menu, then choosing OK until Mail 
OnNet displays the Retrieve Mail Settings dialog box. Under the After Getting Mail option, select Delete 
Copy of Mail on Server, then choose OK.
If you do not change this setting, Mail OnNet will continue to retrieve copies of all of your mail messages. 
This feature complies with the behavior of the POP2 and POP3 network mail protocols.

Related Topics
You cannot receive mail
When Things Go Wrong with Mail OnNet



You forget your Mail OnNet password

Problem
You have forgotten the password that lets you log on to Mail OnNet.

Solution
You must define a new username and password, using the following procedure:
1. Determine the current pathnames of your address book and message store files. They may be stored 

in, for example, c:\explore\user1 for the address book, or c:\pctcp\user1\folders for the message store. 
Retain this information so that you can re-enter it later in this procedure.

2. Start Mail OnNet. In the Mail Logon dialog box, select Create New User.
3. In the User Name box, type your new Mail OnNet username.
4. In the Password box, type your new password, then choose OK.
5. In the User Information dialog box, re-enter your full name, e-mail address, PC name, and mail 

protocols for retrieving and sending mail in the boxes provided.
6. Choose Locations to display the Locations dialog box. In the Address Book and in the Message Store 

boxes, type the current pathnames for the address book files and message store folders, respectively. 
Otherwise, if you accept the new defaults, Mail OnNet will not associate your old information with your 
new username and password.

7. Choose OK to return to the User Information dialog box, then choose OK to proceed to the POP2 or 
POP3 Retrieve Mail Settings dialog box, where you can specify your mail retrieval settings.

8. Choose OK to proceed to the Send Mail Settings dialog box, where you can specify the settings for 
sending mail.

9. Choose OK to continue on to the Mail OnNet main window. 

Related Topic
Configuring Mail OnNet
Logging On to Mail OnNet
When Things Go Wrong with Mail OnNet



You are prompted to supply your POP2 or POP3 username and password

Problem
When you start Mail OnNet, a POP2 or POP3 Login dialog box appears, prompting you to enter your 
POP2 or POP3 password.

Solutions
· Confirm that you have specified the correct username and password pair for the POP2 or POP3 mail 

server. This pair is different from the pair that you use to log in to Mail OnNet; your Internet service 
provider or system administrator assigns the pair to you to allow you to use the services of the mail 
server. Mail OnNet uses the pair to identify you to the server so that Mail OnNet can retrieve your 
messages from it.

If they are incorrect, Mail OnNet may display the POP2 Login or POP3 Login dialog box when you first
start Mail OnNet, to allow you to specify the correct pair. To check that you have specified the pair 
correctly, choose Cancel in the POP2 or POP3 Login dialog box. In the Mail OnNet main window, 
choose Mail Configuration from the Settings menu, then choose OK until Mail OnNet displays the 
Retrieve Mail Settings dialog box. Make certain that you specify the correct username in the Login 
Name box, and the correct password in the Password box, then choose OK until you return to the 
main window.

· Confirm that when you configured Mail OnNet, you specified the correct protocol for retrieving your 
mail. The POP2 protocol is not interchangeable with the POP3 protocol; your mail server uses one or 
the other to allow Mail OnNet to retrieve your messages. To check this setting, choose Mail 
Configuration from the Settings menu. When the User Information dialog box appears, specify the 
correct protocol in the Retrieve Mail Using box. Choose OK, then make certain that your settings are 
correct in the Retrieve Mail Settings dialog box. Choose OK until you return to the main window.

Related Topic
When Things Go Wrong with Mail OnNet



The font used for a printed message is not what you expected

Problem
You print a message and the font used by the printer is not what you expected.

Solution
Choose Set Printer Font from the View menu to change the font used for printing. 

Related Topic
When Things Go Wrong with Mail OnNet



Warning message: rebuilding the folder index

Situation
If you have upgraded from a previous version of Mail OnNet, the application displays a message similar to
the following one about each of your folders when you open them for the first time after the upgrade:
In-Tray format is out of date. Rebuilding list
Explanation
Mail OnNet 2.0 has a different message index format for mail folders than earlier versions of Mail OnNet. 
This message indicates that Mail OnNet will upgrade the format of your folders automatically. No 
messages will be changed or lost.
After an upgrade, you should open all of your folders and allow Mail OnNet to rebuild the message list 
within each folder, one folder at a time. If the folders contain many messages, this process may take a 
while to complete.

Related Topic
When Things Go Wrong with Mail OnNet



Equal signs (=) appear in your sent messages

Problem
When you send mail, equal signs (=) appear in your messages, making them awkward to read.

Explanation
The mail system used by your recipient is not a MIME-compliant mail system; if this is the case, the 
receiving mail system is displaying the messages exactly as they were sent from Mail OnNet. Mail OnNet 
uses a MIME format that a receiving system which lacks MIME compliance is unable to convert into 
normal display characters. 

Related Topic
When Things Go Wrong with Mail OnNet



You want to control the line lengths of your messages

Problem
When you send mail, your mail messages have very long lines in the message body. People receiving 
your mail may complain that it is unreadable, or has such long lines that they must scroll left and right 
continuously.

Solution
Mail OnNet lets you control how to format mail message bodies before you send them. In general, if you 
accept the defaults provided, you will send messages with a maximum line length of 70 characters. This 
length is adequately handled by most mail applications. To review your current settings, choose Compose
Options from the Settings menu.
To restore the default values, select Fixed Size for Message Input, and enter 70 for the number of 
characters.You must specify at least 25 characters for this option.
You should also select the Force Hard Returns option in the Compose Options dialog box. This option 
replaces the soft returns (put in by Mail OnNet to display the message within the width of a Compose 
window) by hard returns when the message is transmitted. This setting retains the appearance of the 
message as it was displayed in the Compose window, so that the mail system of your recipient displays 
the lines of text in the received message body as they once were in the Compose window.

Related Topic
Setting Compose Options
When Things Go Wrong with Mail OnNet



Warning message: bad MIME conversion in an e-mail address

Problem
Mail OnNet displays a message dialog box with a message similar to this one:
The address John J. Doe <jdoe@xyz.com> has failed to parse properly. It will 
be ignored, which may cause side effects.
Solution
Choose OK. Mail OnNet will allow the message into your message store. Certain keyboard characters, 
such as the dot (.), the at-sign (@), and bracket characters (such as the angle brackets (<>)) are treated 
as special characters in electronic mail addresses. You may see these characters surrounded by double 
quotation marks (as in John "J." Doe) when you display the message in a Read window.
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Messages are moved into the wrong folder by a task

Problem
You have several tasks which move mail messages from the In-Tray to various folders, based on a match 
criterion in the Subject, To, From, or Message Text fields. Not all the messages end up in the folder you 
expected.
Generally, this problem happens when the match criterion for one task is a string that is a subset of the 
match criterion string of another task. For example, you have two tasks:
Task 1: Put messages whose subject field contains Fun into the folder named Fun
The purpose of this task is to match any messages whose Subject field contains the text string "fun, and 
move them to the folder named Fun.

On Event: New Mail
When Matching Subject Contains: fun
Perform Action: Move Message to Fun Folder

Task 2: Put messages whose subject field contains Functional Specifications into the folder 
named Specs
The purpose of this task is to match any messages whose Subject field contains the string "Functional 
Specification," and move them to the folder name Specs.

On Event: New Mail
When Matching Subject Contains: Functional Specification
Perform Action: Move Message to Specs Folder

In this particular example, if Task1 executes first, all mail messages with the subject Functional 
Specification will be moved into the Fun folder. 

Solution
To prevent this situation, always specify a string to match that is as specific as possible, so that the 
likelihood of task overlap is decreased. If you must create overlapping tasks, you can:
1. Create a task that triggers on new mail and moves all matching messages for the shortest string into a

folder.
2. Create additional tasks that trigger on the event Add Mail to Folder, specifying the name of the folder 

from the previous step. For the additional tasks, specify the longer strings as the match criteria, then 
move the messages to the folders into which you want them to go.

An example of tasks that use this technique is:
On Event: New Mail
When Matching Subject Contains: fun
Perform Action: Move Message(s) to Fun Folder

and
On Event: Add Mail to Folder: Fun
When Matching Subject Contains: Functional Specification
Perform Action: Move Message(s) to Specs Folder

In this revised example, if Task1 executes first, all mail messages with the subject Functional 
Specification will be moved into the Fun folder, whereupon Task 2 will be triggered to move those 
messages into the folder named Specs. 
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Task Tips

· You cannot predict the order in which tasks may execute. Plan your tasks so that they are not 
dependent upon the execution of another task.

· If you think that a certain task may be responsible for unexpected behavior, you can disable the task in
the Task Manager dialog box.

· Make certain that you understand the difference between And matches and Or matches when setting 
up your match criteria. For example, if you use And when you mean Or, it is possible that your match 
criteria will never be met.

· Make certain that you use any case sensitivity options available to you when you set up a task, if it will 
help to make the match criteria more specific.
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Technical assistance

Users in the U.S. and Canada, and worldwide resellers    Contact FTP Software®:

Telephone: (800) 382-4387
(508) 685-3600

E-mail: support@ftp.com
Fax: (508) 794-4484

 or 

Users outside of the U.S. and Canada    Contact your local reseller.

Tip
For FREE online technical services, see:

World Wide Web: http://www.ftp.com
Anonymous Ftp Server: ftp.ftp.com
Bulletin Board System: (508) 684-6240 ( settings    8,N,1)
CompuServe: GO FTPSOFT (PCVENJ Section 8)




